Modeling a Part Using Surfaces
# Contents

**Introduction** ................................................................. 1-1  
**Surface construction** ....................................................... 2-1  
  - What is surfacing and why use it? ........................................ 2-3  
  - Surface construction advantages ........................................ 2-4  
  - Surface construction overview ......................................... 2-5  
  - General surface modeling workflow .................................. 2-6  
  - Working with points, curves, and surfaces ......................... 2-11  
**Creating and editing curves** ............................................... 3-1  
  - Surface modeling approach ............................................. 3-2  
  - Overview of splines ..................................................... 3-3  
  - Curve command ............................................................. 3-4  
  - Curve definition .......................................................... 3-9  
  - Curve display and edit .................................................. 3-12  
  - Curve Options dialog box .............................................. 3-17  
  - Simplify Curve command ............................................... 3-18  
  - Simplify Curve Dialog Box ............................................ 3-19  
  - Convert To Curve command ............................................ 3-21  
  - Activity: Drawing and editing a curve .............................. 3-23  
  - BlueDot command (ordered modeling) ................................ 3-24  
  - BlueDot Edit command bar (ordered modeling) ..................... 3-26  
  - Connect sketch elements with a BlueDot ........................... 3-28  
  - Activity: Creating and editing BlueDots ............................ 3-29  
  - Lesson review .............................................................. 3-30  
  - Answers ............................................................................. 3-31  
  - Lesson summary ............................................................. 3-32  
**Indirect curve creation techniques** ...................................... 4-1  
  - Additional curve creation methods .................................... 4-2  
  - Pierce points ...................................................................... 4-22  
  - Silhouette points ............................................................ 4-23  
  - Insert Image command ..................................................... 4-23  
  - Insert Image dialog box .................................................... 4-24  
  - Insert Image command bar ............................................... 4-24  
  - Points, curves (and surfaces) as construction elements ......... 4-26  
  - Lesson review .............................................................. 4-29  
  - Answers ............................................................................. 4-29  
  - Lesson summary ............................................................. 4-29  
**Surface creation** ................................................................. 5-1  
  - Overview of surfaces ...................................................... 5-2  
  - Creating a simple surface ................................................. 5-3  
  - Activity: Creating and editing simple surfaces .................... 5-6
Using simple surfaces as construction surfaces .................................. 5-6
Tear-Off Sketch .................................................................................. 5-7
Tear-Off Sketch command ................................................................... 5-7
Swept Surface command ...................................................................... 5-9
Sweep Options dialog box ..................................................................... 5-9
Activity: Creating a swept surface .......................................................... 5-17
Lofted Surface command (ordered modeling) ........................................ 5-18
Bounded Surface command .................................................................. 5-20
BlueSurf .............................................................................................. 5-21
Lesson review ...................................................................................... 5-46
Answers .............................................................................................. 5-46
Lesson summary .................................................................................. 5-46

**Surface manipulation tools** ............................................................... 6-1

- Extend Surface command .................................................................. 6-2
- Extend Surface command bar ............................................................. 6-3
- Offset Surface command ................................................................... 6-6
- Offset Surface command bar .............................................................. 6-7
- Copy Surface command .................................................................... 6-8
- Copy Surface command bar ............................................................... 6-9
- Trim Surface command ..................................................................... 6-10
- Delete Faces command ..................................................................... 6-12
- Stitched Surface command ................................................................. 6-13
- Round ............................................................................................... 6-15
- Replace Face command .................................................................... 6-21
- Activity: Surface manipulation ......................................................... 6-22
- Split Face Command ......................................................................... 6-23
- Parting Split command ..................................................................... 6-25
- Parting Surface command .................................................................. 6-26
- Activity: Parting split and parting surface ......................................... 6-27
- Activity: Creating a rotary razor body ............................................... 6-28
- Activity: Putting it all together ........................................................... 6-29
- Lesson review ................................................................................... 6-30
- Answers ............................................................................................ 6-30
- Lesson summary ................................................................................ 6-30

**Curve and surface inspection tools** .................................................. 7-1

- Curvature Comb command .................................................................. 7-2
- Surface inspection tools ...................................................................... 7-3
- Lesson review .................................................................................. 7-7
- Answers ............................................................................................ 7-7
- Lesson summary ................................................................................ 7-7

- **Activity: Drawing and editing a curve** ................................................. A-1

- Draw a curve ...................................................................................... A-1
- Hide the sketch containing edit points ................................................ A-2
- Edit the curve shape .......................................................................... A-3
- Add more control to the curve ............................................................. A-5
- Inspect the curve using Curvature Comb ........................................... A-9
- Draw a curve connected to elements ................................................ A-11
- Constrain the curve .......................................................................... A-12
- Summary ........................................................................................... A-18
Activity: Creating and editing BlueDots ........................................ B-1
  Use BlueDots to connect two curves ........................................ B-2
  Connect the four curves at the end points ................................. B-2
  Edit a BlueDot .......................................................................... B-3
  Summary .................................................................................... B-8

Activity: Creating keypoint curves ............................................. C-1
  Create a keypoint curve ............................................................ C-1
  Create keypoint curves between the sketches ............................ C-4
  Connect the keypoint curves with BlueDots ............................... C-5
  Edit a BlueDot .......................................................................... C-6
  Include tangency on keypoint curves ........................................ C-8
  Summary .................................................................................... C-10

Activity: Additional curve creation methods .............................. D-1
  Create an Intersection curve ..................................................... D-1
  Create a cross curve .................................................................. D-2
  Project a curve ........................................................................... D-4
  Create a contour curve .............................................................. D-7
  Edit the shape of the contour curve ............................................ D-8
  Use the derived curve and split curve creation methods ............... D-10
  Summary .................................................................................... D-14

Activity: Creating and editing simple surfaces ......................... E-1
  Create an extruded surface ....................................................... E-1
  Modify the shape of the extruded surface .................................. E-2
  Create a revolved surface ........................................................ E-3
  Edit the shape of the revolved surface ...................................... E-4
  Summary .................................................................................... E-4

Activity: Creating a swept surface ............................................ F-1
  Create a swept surface ............................................................. F-1
  Modify the shape of the surface ............................................... F-3
  Dynamically edit the path curve ................................................. F-4
  Summary .................................................................................... F-5

Activity: Creating a BlueSurf using analytics .............................. G-1
  Create several BlueSurf features ................................................ G-1
  Create another BlueSurf ............................................................ G-2
  Create a third BlueSurf .............................................................. G-5
  Add cross sections to the BlueSurf ............................................. G-6
  Summary .................................................................................... G-9

Activity: Creating and editing a BlueSurf .................................. H-1
  Create a BlueSurf with guides ................................................... H-1
  Insert sketches on the BlueSurf ................................................ H-2
  Perform BlueDot edits to change the shape of the surface ............ H-6
  Summary .................................................................................... H-9
Activity: Surface manipulation ............................................. I-1
  Extend a surface ....................................................... I-1
  Offset a surface ..................................................... I-3
  Project a curve onto a surface .................................... I-5
  Trim a surface ....................................................... I-7
  Copy a surface ...................................................... I-9
  Delete faces ........................................................ I-10
  Stitch surfaces ...................................................... I-14
  Replace a face ........................................................ I-18
  Summary ............................................................. I-20

Activity: Parting split and parting surface ............................... J-1
  Create a sketch ....................................................... J-1
  Create the core part ............................................... J-2
  Create the cavity .................................................. J-3
  Create a parting split curve on the cavity ....................... J-5
  Create a parting surface ......................................... J-6
  Divide the part ..................................................... J-8
  Open each of the two mold halves ................................ J-11
  Summary ............................................................. J-13

Activity: Creating a rotary razor body .................................. K-1
  Create an extruded surface ........................................ K-2
  Create a curve ....................................................... K-3
  Sketch a cross-section ............................................. K-4
  Create additional curves .......................................... K-5
  Create a BlueSurf .................................................. K-11
  Create a bounded surface ......................................... K-13
  Stitch together the surfaces ..................................... K-14
  Create a reference plane ......................................... K-15
  Create an opening for the power button ......................... K-16
  Create a port for the power cord ................................ K-18
  Split the solid body into two ..................................... K-19
  Offset the rear surface ........................................... K-21
  Create a space for additional razor components ............... K-22
  Apply a thin wall to the part .................................... K-25
  Round edges ........................................................ K-26
  Summary ............................................................. K-27

Activity: Putting it all together .......................................... L-1
  Construct the top surface ......................................... L-2
  Create intersection curves to develop the front surface .... L-6
  Create intersection curves to develop the side surfaces .... L-9
  Create the bottom surface ....................................... L-13
  Add another surface .............................................. L-18
  Create the final surface ......................................... L-21
  Cap the ends ......................................................... L-24
  Stitch together the surfaces ..................................... L-24
  Summary ............................................................. L-25
Lesson

1 Introduction

Welcome to self paced training for Solid Edge. This course is designed to educate you in the use of Solid Edge. The course is self-paced and contains instruction followed by activities.

Solid Edge self-paced courses

- spse01510—Sketching
- spse01515—Constructing base features
- spse01520—Moving and rotating faces
- spse01525—Working with face relationships
- spse01530—Constructing treatment features
- spse01535—Constructing procedural features
- spse01536—Modeling synchronous and ordered features
- spse01540—Modeling assemblies
- spse01545—Creating detailed drawings
- spse01546—Sheet metal design
- spse01550—Practicing your skills with projects
- spse01560—Modeling a Part Using Surfaces
- spse01610—Solid Edge frame design
- spse01640—Assembly patterning
- spse01645—Assembly systems libraries
- spse01650—Working with large assemblies
- spse01655—Revising assemblies
- spse01660—Assembly reports
- spse01665—Replacing parts in an assembly
- spse01670—Designing in the context of an assembly
Lesson 1  

Introduction

- spse01675—Assembly features
- spse01680—Inspecting assemblies
- spse01685—Alternate assemblies
- spse01686—Adjustable parts and assemblies
- spse01690—Virtual components in assemblies
- spse01691—Exploding assemblies
- spse01692—Rendering assemblies
- spse01693—Animating assemblies
- spse01695—XpresRoute (tubing)
- spse01696—Creating a Wire Harness with Harness Design
- spse01424—Working with Solid Edge Embedded Client

Solid Edge self-paced modules

- spse01510—Sketching
- spse01515—Constructing base features
- spse01520—Moving and rotating faces
- spse01525—Working with geometric relationships
- spse01530—Constructing treatment features
- spse01535—Constructing procedural features
- spse01536—Modeling synchronous and ordered features
- spse01540—Modeling assemblies
- spse01545—Creating detailed drawings
- spse01546—Sheet metal design
- spse01550—Practicing your skills with projects

Start with the tutorials

Self-paced training begins where tutorials end. Tutorials are the quickest way for you to become familiar with the basics of using Solid Edge. If you do not have any experience with Solid Edge, please start by working through the tutorials for basic part modeling and editing before starting this self-paced training.
Lesson

2 Surface construction

Solid Edge provides two distinct 3D modeling styles: solid modeling and surface construction.

The solid modeling method

1. A product's function is the primary concern and aesthetics are purely an afterthought.

2. Solid Edge is an industry leader of this modeling style and exhibits these additional characteristics:
   - The various modeling operations are identified as features.
   - A history tree of features is maintained.
   - All properties used in defining a feature can be edited at any time.
1. Many consumer products are designed using surface modeling techniques due to the market’s emphasis on style and ergonomics; therefore, a model’s aesthetics is the number one concern and key element in the design process. Product function is only a secondary consideration.

2. Like the solid modeling features, Solid Edge extends this style by making each point, curve, and surface an entity that knows how it was created, and can be edited at any time.
What is surfacing and why use it?

The solid modeling method is typically used when modeling with solid features. The following are key features of the solid modeling approach:

- It is characterized by 2D sketches/profiles used in creating extrusions, revolutions, and lofts to form solids, and blends on the edges of solids.
- It most often involves the addition or subtraction of material using analytic shapes.
- The model’s topology is driven by faces.
- Holes are used for alignment.
- Feature faces are used for alignment as well as for mating with other features.
- Edges are rounded for safety and strength.
- Edges and faces are primarily analytic-based.
Modeling with surface-based features typically begins with a wireframe, from which surfaces are generated. Key features of surface modeling:

- It is characterized by control points used to define 2D and 3D curves.
- A model’s topology is driven by edges and curves. Edges and faces are mainly based on splines.
- Surface shapes are very important, therefore direct editability of underlying curves and edges is crucial.
- Highlight lines, silhouette edges and flow lines of a model are important.

**Surface construction advantages**

For some types of parts, the surface modeling approach offers distinct advantages. For example, when modeling the faucet shown using revolved features, the shape of the edges (A) is the result of two intersecting surfaces. To change the shape of the
edges, you must edit the surfaces. Often it is difficult to get the surface aesthetics you want.

With a surface modeling approach, you have much more control by using character curves. Character curves can be hard edges or soft edges. Hard edges are actual model edges (A), while soft edges are theoretical, view-dependent edges, such as when viewing a curved surface (B) from the side (C). Soft edges are also known as silhouette edges. Both types of edges are important for defining the flow, aesthetics, and overall shape of a surface.

**Surface construction overview**

Solid Edge provides two distinct 3D modeling styles: solid modeling and surface construction.

Many surface construction features require you to define cross section and guide curves. You can define cross section and guide curves using analytic elements or B-spline curves.

An analytic element can consist of:

- A 2D element: Line, arc, circle, ellipse, parabola, or hyperbola.
- A derived element: such as the intersection of a cone and a plane.
- A 3D element: a cube, sphere, cylinder, cone, or torus.
Lesson 2  

*Surface construction*

A b-spline element can consist of:

- A 2D element, such as a B-spline curve.
- A derived element, such as the intersection of two non-planar surfaces.
- A 3D element, such as a 3D B-spline curve or free-form surface.

**Note**

A spline was originally a tool made from wood or thin metal which was used to draw a curve through points.

---

**General surface modeling workflow**

1. **Create control drawings.**

   *Definition:* Control Drawings are 2D drawing views defining the top, side, and end views. Typically one or two views dominate (define the majority of the shape).
Part environment: You can create control drawings directly by drawing on reference planes. Pierce points aid in connecting curves.

Draft environment: You can create control drawings in 2D, then use Copy and Paste to transfer the 2D elements from Draft into Part. Also, you can use Create 3D or import sketches.

Tip

While drawing any sketch element in either the Part or Draft environment, use Line Color to help distinguish edges and construction edges in the control drawing.

- Draw all character curves.
- Do not over draw. Do not model rounds, ribs, or features best created with solid features.
- Capture design intent. Add dimensions and constraints.
- Create simple B-splines with few Edit Points.
- Make sure view sketches register.
- Build edge continuity into your sketches.

2. **Use 2D geometry to develop 3D curves.**

- Project curves from control drawings.
- You may need some construction surfaces to generate 3D curves. This is very important in reducing modeling steps.
- 3D curves give simplified control over edges.
Lesson 2  
*Surface construction*

- Capture your design intent by using control drawings.

- Without 3D curves, character edges may not be captured.

- Lack of 3D edges eliminates design intent and adds more modeling.

- With 3D curves, design intent is preserved and modeling is reduced.

- You can easily change the shape by altering the character curves for the respective view.
• Creating 3D edges guarantees an accurate design and reduces modeling steps.

• Making changes to the 3D curve is simple. Edit the character curve in the control drawing.

• Repeat the process until all 3D curves are created
  – A wireframe representation of the model should result.
  – All 3D curves should be touching.
Lesson 2  Surface construction

3. Use 3D curves to develop surfaces.
   - *BlueSurf* command.
     Inputs are guides and sections.

   - *Swept* command.
     Inputs are guides and sections.

   - *Bounded* command
     N-sided patch.
4. **Create a solid and add appropriate solid based features.**
   - Stitch together surfaces
   - Add solid-based features
     - Thinwall
     - Stiffening Rib
     - Hole
     - Round
     - Web network
     - Lip

5. **Tweak.**
   - Analyze edge continuity using:
     - Curvature Comb
     - Zebra Stripes
   - Edit character curves
   - Edit tangent vectors
   - Edit vertex mapping

**Working with points, curves, and surfaces**

You can use commands in Solid Edge to create points, curves, and surfaces. These elements are typically used to construct part features, and are often referred to as construction elements. For example, you can use a single, curved surface to replace several planar faces on a model. Using points, curves, and surfaces helps you model complex design scenarios more quickly.
Lesson 2  

*Surface construction*

You can also use these commands when working with foreign data that you have imported into Solid Edge.

For some model types, you may not use the solid modeling commands until very late in the modeling process. Complex, freeform parts often require that you begin the modeling process by defining points and curves that are used to define and control the surfaces that comprise the model. Surfaces are then generated, and in the final steps, the surfaces are stitched together to form a solid model. For more information on this type of workflow, see the Surface construction Help topic.

**Note**

Construction elements that drive other features have a parent-child relationship with the features they drive. If you delete a construction element that is a parent to another feature, you can invalidate the other feature.

**Displaying points, curves, and surfaces**

The construction elements you create are listed in the Feature PathFinder window. You can control whether construction elements are listed in Feature PathFinder using the PathFinder Display commands on the Feature PathFinder shortcut menu. For example, to display construction elements in Feature PathFinder, click the right mouse button within Feature PathFinder, then point to PathFinder Display, and then set the Constructions option.

**Note**

You can change the default color for construction elements using either the Color Manager command or the Colors tab on the Options dialog box.

When you use construction elements to help you construct new features on a solid model, the construction elements are not consumed by the new feature. For example, if you use a construction surface to help you define the extent for a protrusion, a trimmed copy of the construction surface is used to create the protrusion. The construction surface remains, but it is hidden automatically.

![Construction elements](image)

You can control the display of construction elements in the graphic window using the Construction Display command or the Show and Hide commands on the shortcut menu. When you hide a construction element, its entry in Feature PathFinder changes to indicate that it is hidden.

When working with Solid Edge documents that contain construction surfaces and a solid design body, it can be useful to hide the design body while you are working with the construction surfaces. You can use the Show Design Body and Hide Design body commands to control the display of the design body.
Creating points, curves, and surfaces

You can create these elements using the following methods:

- Generate them using other geometry on the model. For example, you can create points and curves at the intersection of other curves and surfaces.
- Create them from scratch. For example, you can create extruded, revolved, and swept surfaces using the Solid Edge construction surface creation commands.
- Generate them using an external file. For example, you can create a helix curve using coordinate data in a spreadsheet.
- Import them from another CAD system. For example, you can import surfaces and solids from a third-party CAD system.
- Generate them as a part copy from another Solid Edge part. For example, you can create construction geometry using the Part Copy command.

Using points and curves

You can use points and curves in the following ways:

- To help you create other features - You can use a construction point or curve as a path or cross section for lofted and swept features.
- To help you create a reference plane - You can use a construction curve as input to the Plane Normal To Curve command.
- To help you define the extents of another feature - You can use keypoints of construction curves to define the extent for a feature.

For example, you can use 3D construction curves as paths during the creation of swept features.

You can use the Intersection Point command to create associative points at the intersection of edges and other curves. You can then use these points as input to define the extents of a feature. You can also use points as cross sections when creating lofted features.
You can create open or closed curves using the Intersection Curve, Keypoint Curve, Derived Curve, and Curve By Table commands. You can then use these curves to define paths and cross sections for lofted and swept features, and as profiles for profile-based features and construction surfaces.

The Project Curve command projects a curve onto a part face. You can then use the projected curve as a profile for either a protrusion or a cutout feature. This is a useful technique for creating embossed text on a curved surface.

The Split Curve command splits a curve into multiple curves. Splitting a curve can make it easier to create other geometry, such as a surface by boundary or a normal protrusion.

**Using surfaces**

The surfacing commands help you create complex parts and surface topology more easily. You can use surfaces in the following ways:

- To define the projection extents when extruding a feature.
- To replace existing part faces.
- To divide a part into multiple parts.
- To create a new surface or solid by stitching together separate surfaces.
- To repair a model you imported from a third-party CAD system.

Construction surfaces are commonly used as projection extents when extruding a feature. For example, you can create a construction surface, then use the surface as input during the Extent step when constructing a protrusion.

You can use the Offset Surfaces command to offset a new surface. The options on the command bar allow you to specify whether you want to offset a single face, a chain of faces, or all the faces that make up a feature.
You can use the Stitched Surface command to stitch together Solid Edge surfaces, as well as surfaces created with another CAD system and then imported into Solid Edge.

You can also create surfaces using the Part Copy command. If the Copy As Construction option is set in the Part Copy Parameters dialog box, the part copy is created as a construction surface.

**Evaluating surfaces**

When working with surfaces, it is sometimes useful to visualize the curvature of a surface to determine if there are surface discontinuities and inflections. You can use the Zebra Stripes command to display zebra stripes on the model.

You must also shade the active window using the Shaded or Shaded With Visible Edges commands to display zebra stripes.
Evaluating and repairing foreign data

When you import surfaces that do not form a closed volume, they are imported as construction geometry. If the imported surfaces form a closed volume, you have the option to create a solid body.

If the imported surfaces do not form a solid body in Solid Edge, but were created as a solid body in the other CAD system, the accuracy of the data prevented it from being converted into a solid body in Solid Edge. Typically, the surface-to-surface matching tolerances used in the source system were larger than the Parasolid modeling kernel requires for successful stitching of the surfaces into a solid body. Some CAD systems allow surface-to-surface matching tolerances that are quite large, in some cases larger than the manufacturing tolerances of the manufactured part. The surface-to-surface matching tolerance requirements of the Parasolid modeling kernel are more exacting.

You can use the Geometry Inspector command to determine what problems the model has and then you can use the construction commands to modify the model to repair the problem areas. For example, there may be surfaces that did not import correctly, or there may be gaps or overlaps between individual surfaces in the model. Geometry Inspector evaluates the model and builds a list of the problem areas and provides suggestions as to how you can repair the problems.

If there are areas that did not stitch properly, you can use the Show Non-Stitched Edges command to display the non-stitched areas. You can then use the other commands on the Surfacing tab to repair the existing surfaces, or create new surfaces and stitch them into the model. You can also delete surfaces that would be easier to recreate from scratch than to repair.

Both curve and surface manipulation commands are available for creation and modification of construction elements. You can use the Derived Curve, Split Curve, Project Curve, and Intersection Curve commands to create new curves or modify existing curves. You can use the Trim Surface, Extend Surface, and Delete Face commands to modify or delete construction surfaces. You can use the Extruded Surface, Revolved Surface, Swept Surface, Lofted Surface, and Bounded Surface commands to create new construction surfaces. For example, if an imported surface overlaps another surface, you can use the Derived Curve command to extract a curve from the edge of the surface it overlaps, then use the new derived curve as input with the Trim Surface command to trim the existing surface.

If the non-stitched edges are the result of a missing surface, you can use the construction commands to create a new surface and stitch it into the model. For example, you can create an extruded, revolved, swept, and lofted construction surface to close a gap in a model.
When repairing imported data, you may need to try several approaches before finding one that succeeds. For example, if you are unsuccessful creating a revolved surface, try creating an lofted surface. The tolerance issues inherent with imported data can make model repair difficult.

After you have repaired a surface, or created a new surface, you can then use the Stitched Surface command to add the new surface to the model. If the stitched surfaces form a closed volume, you have the option to create a solid body. You can then use the solid body to complete the modeling process.
Lesson

3 Creating and editing curves

Objectives

After completing this lesson, you will be able to:

• Create curves.

• Edit curves.

• Analyze curves.

• Create BlueDots.

• Edit BlueDots.
Surface modeling approach

The backbone of surface modeling is made up of cross sections and guides. Cross sections and guides can be of entity type analytic or spline.

An analytic entity type consists of:
- 2D: Lines, arcs, circles, ellipse, parabola, hyperbola.
- The intersection of a plane and a cone.
- 3D: Cubes, spheres, cylinders, cones, tori.

A spline entity type consists of:
- 2D: constructed spline curves, derived curves.
- 3D: derived spline curves.

A solid modeling method using revolved features results in no edge control and difficult edits. Edge (A) is a result of the intersection of two revolved surfaces. You don’t have direct control over the result.
A surface modeling method results in exact edge control and edges are based on character curves. You have direct control over edges such as (A).

Overview of splines

A spline is a standard curve in most CAD systems. Unlike lines and conic curves, generally categorized as analytics, the spline can be adjusted to virtually any shape in two or three dimensions. Their flexible nature makes splines the foundation for surface modeling.

A spline entity type consists of:

- 2D: constructed spline curves, derived curves.
- 3D: derived spline curves.

**Note**

Originally, a spline was a stylist's tool made from wood or thin metal and used to draw a curve through points.
Lesson 3  Creating and editing curves

Shown below is a 2D spline.

Shown below is a 3D surface based on a spline.

For the remainder of this course, the term *curve* is used instead of splines. Just remember that curves are splines. Two types of curves are discussed:

- *Constructed*—You have direct control of constructed curves.
- *Derived*—Derived curves are controlled by the method used to create them. Derived curves cannot be edited directly.

**Curve command**

Draws a smooth, B-spline curve by points. You can click and drag to define a freehand curve, or you can click to create edit points to define the curve. If you click edit points, you must define at least three points to create the curve.
Creating and editing curves

When you create a curve, edit points (A) and curve control vertex points (B) are created to help you edit and control the shape of the curve.

Closing curves

You can use the Closed option on the Curve command bar to create a continuous line that forms a closed curve connected tangentially at the first and last point you click.

<table>
<thead>
<tr>
<th>Closed option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td><img src="image" alt="Off" /></td>
</tr>
<tr>
<td>On</td>
<td><img src="image" alt="On" /></td>
</tr>
</tbody>
</table>

When editing a curve created from edit points, you also can use the Closed option to:

- Close an open curve, without adding points.
- Open a closed curve, without deleting points.

You cannot use this option to modify a freehand curve.

Displaying curves

You can use the options on the Curve command bar to control the display of a curve.
The Add/Remove Points button adds or removes edit points along the curve. When you add an edit point, the shape of the curve does not change. If the number of edit points on the curve is the same as the number of control vertex points, adding an edit point adds a corresponding control vertex point. The control vertex point moves to maintain the shape of the curve.

When you remove edit points, the control vertex points move, and the shape of the curve changes.

**Note**

If there are only two edit points on the curve, you cannot remove an edit point from the curve.

See Insert or remove points on a curve.

The Show Polygon button displays the control polygon of the curve, which you can use to edit the curve.

The edit points and control vertex points are handles that you can drag to change the shape of the curve.

**Note**

You can also use these points as keypoints for relationships and dimensions.
The Show Curvature Comb button displays the curvature comb for the curve. This helps you determine how quickly or gradually curves change and where they change direction.

You can use the Curvature Comb Settings command to control the density and magnitude of the curve.

**Editing curves**

The Curve command bar controls how the shape of the curve changes when you make changes to the edit points and control vertex points.

The Shape Edit and Local Edit buttons control the shape of the curve when you move a point on the curve.

When you select the Shape Edit button, you affect the shape of the entire curve when you move a point on the curve.

When you select the Local Edit button, you affect the shape of the curve around the edit point.

With Local Edit, if you drag a vertex point on an unconstrained curve, no other vertex points will move. However, if you drag a vertex point on a curve that has some relationships, then other vertex points may move as well. This allows the curve
to adapt to the new location of the vertex point you moved while still maintaining the relationships.

**Note**

You cannot drag an edit point that is fully constrained.

You can select the Curve Options button to display the Curve Options dialog box. You can use this dialog box to change the number of degrees for the curve and to specify the relationship mode for the curve. You can set the relationship mode to:

- Flexible
- Rigid

In Flexible mode you can use external relationships to control the shape of the curve. For example, you can apply a dimension relationship on the curve and as you make changes to the dimensions, the shape of the curve automatically updates.

In Rigid mode you cannot use external relationships to control the shape of the curve. Instead, the curve shape remains unchanged and the curve simply rotates.

**Simplifying curves**

You can use the Simplify Curve command to simplify a polygon-based curve by reducing the number of edit points and control vertex points on a curve. The Simplify Curve dialog box increases or decreases a fit tolerance for the curve.

**Note**

Simplifying a curve can cause the relationships placed on a curve to be deleted.
Curve definition

The shape of a curve is dependent on the number of control and edit points. These elements are determined by standard polynomial expressions.

Curve order

The order of a curve is equal to the degree of the curve, plus 1 (Order = Degree + 1).

A polynomial curve is defined as:
\[ x(t) = x_0 + x_1(t_1) + x_2(t_2) + x_3(t_3) \]
\[ y(t) = y_0 + y_1(t_1) + y_2(t_2) + y_3(t_3) \]
Determining control vertices

If the number of edit points is two or three, then the number of Control Vertices = Order.

Example:
Edit points = 3
Degree = 8
Order = 9 (Degree + 1)
Control Vertices = 9

If the number of edit points is >= 4, the number of control vertices is \((n+2) + [(n-1) \times (k-4)]\).
Where \(n = \) Edit Points, and \(k = \) Order.

Example:
Edit points = 7
Degree = 5
Order = 6 (degree + 1)
Control Vertices = 21
For more information on curve options, refer to:

**Curve Options dialog box**
Curve display and edit

Displaying curves

You can use the options on the Curve command bar to control the display of a curve.

The Add/Remove Points button adds or removes edit points along the curve. When you add an edit point, the shape of the curve does not change. If the number of edit points on the curve is the same as the number of control vertex points, adding an edit point adds a corresponding control vertex point. The control vertex point moves to maintain the shape of the curve.

When you remove edit points, the control vertex points move, and the shape of the curve changes.

**Note**

If there are only two edit points on the curve, you cannot remove an edit point from the curve.

See Insert or remove points on a curve.

The Show Polygon button displays the control polygon of the curve, which you can use to edit the curve.

The edit points and control vertex points are handles that you can drag to change the shape of the curve.
Creating and editing curves

Note
You can also use these points as keypoints for relationships and dimensions.

The Show Curvature Comb button displays the curvature comb for the curve. This helps you determine how quickly or gradually curves change and where they change direction.

You can use the Curvature Comb Settings command to control the density and magnitude of the curve.

Editing curves
You can edit curves at any time via one of two methods for editing curves.

1. Edit Profile mode: Just like editing a sketch.

2. Dynamic Edit mode: Shows all of the control and edit points.
Lesson 3  

Creating and editing curves

When you move a control point or edit point, the curve updates automatically; any surface that has the curve as one of its defining entities will update dynamically.

The Add/Remove Points and Curve Options buttons are disabled in dynamic edit mode. These options are only available in Edit Profile mode.

Add/Remove Points

Show Polygon

Show Curvature Comb

Shape Edit

Local Edit

Close Curve

Curve Options

The Curve command bar controls how the shape of the curve changes when you make changes to the edit points and control vertex points.

The Shape Edit and Local Edit buttons control the shape of the curve when you move a point on the curve.

When you select the Shape Edit button, you affect the shape of the entire curve when you move a point on the curve.

When you select the Local Edit button, you affect the shape of the curve around the edit point.
With Local Edit, if you drag a vertex point on an unconstrained curve, no other vertex points will move. However, if you drag a vertex point on a curve that has some relationships, then other vertex points may move as well. This allows the curve to adapt to the new location of the vertex point you moved while still maintaining the relationships.

**Note**

You cannot drag an edit point that is fully constrained.

You can select the Curve Options button to display the Curve Options dialog box. You can use this dialog box to change the number of degrees for the curve and to specify the relationship mode for the curve. You can set the relationship mode to:

- **Flexible**
- **Rigid**

In Flexible mode you can use external relationships to control the shape of the curve. For example, you can apply a dimension relationship on the curve and as you make changes to the dimensions, the shape of the curve automatically updates.

In Rigid mode you cannot use external relationships to control the shape of the curve. Instead, the curve shape remains unchanged and the curve simply rotates.
Simplifying curves

You can use the **Simplify Curve command** to simplify a polygon-based curve by reducing the number of edit points and control vertex points on a curve. The **Simplify Curve dialog box** increases or decreases a fit tolerance for the curve.

**Note**

Simplifying a curve can cause the relationships placed on a curve to be deleted.
Curve Options dialog box

Relationship Mode
Specifies the relationship mode that controls how relationships, such as connects, tangencies, and dimensions, affect the shape of the curve. You can set the relationship mode to flexible or rigid.

- Flexible mode allows you to use external relationships to control the shape of the curve. For example, you can apply a dimension relationship on the curve and as you make changes to the dimensions, the shape of the curve automatically updates.

- Rigid mode does not allow external relationships to control the shape of the curve. Instead, the curve shape remains unchanged and the curve simply rotates.

Curves created in versions of Solid Edge prior to V14 support rigid mode behavior, but not flexible mode behavior.

Degree
Specifies the number of degrees for the curve. You can specify a number between 2 and 10.

- If you increase the number of degrees the control polygon for the curve changes, but the shape of the curve remains the same.
If you decrease the number of degrees, the control polygon for the curve changes and the curve changes size based on the supplied edit points.

**Procedures**
- Draw a curve

**Commands**
- Curve command

**Simplify Curve command**

Reduces the number of edit points for a curve.
- Curve data can be manually created or can be read in from foreign data.
- Manually created curve data usually contains a limited number of control points.
- Foreign data may come from a digitized set of control points, which could contain a large amount of points.
- Simplify curve is a tool that allows you to define a tolerance to reduce the number of edit points and control vertices.

The command works differently depending on the type of curve. For edit point based curves, once you reduce the number of edit points to two, the command reduces the control poles. Control polygon based curves only have two edit points, so the command reduces the control poles.

Right-click on a curve and select Simplify to access its dialog box; for more information, refer to the Simplify Curve dialog box topic:

**Simplify Curve dialog box**
Simplify Curve Dialog Box

Applies a simplify tolerance to a selected curve and shows the original and current curve statistics.

Tolerance
Specifies the tolerance you want to apply to the selected curve.

Note
Visualize tolerance as a tube. The original curve is at the center of a zero diameter tube. As the tube diameter (tolerance) increases, edit points are reduced as the curve shape is confined to the tube diameter. As the tolerance increases the curve is simplified.

Note
You can visually observe the curve simplification process as the tolerance increases using the right arrow in the dialog box.

Simplify
Simplifies the curve based on tolerance displayed in the Tolerance box. You can use the arrows on either side of the Simplify button to increase or decrease the tolerance and simplify the curve.

Status
Displays the status of the edit points, control points, and simplified tolerance for the curve.

Original # of edit points
Displays the number of edit points for the original curve.

Current # of edit points
Displays the number of edit points for the simplified curve.

Original # of control vertices
Displays the number of control points for the original curve.

Current # of control vertices
Displays the number of control points for the simplified curve.

Simplified Tolerance
Displays the tolerance for the simplified curve.

The following is an example of a curve with a large number of edit points and control vertices. Simplify curve was used to reduce the number of points. The curve shape changed slightly. You can visually observe the curve changes as the tolerance increase.
Lesson 3  Creating and editing curves

(1) Original curve
(2) Original curve in edit mode with 25 edit points and 27 control vertices
(3) Dynamic display as curve simplify tolerance is increased
(4) Resulting simplified curve reduced to 7 edit points and 9 control vertices
(5) Simplified curve

---

Procedures

• Simplify a curve

Commands

• Simplify Curve command
**Convert To Curve command**

Converts analytic geometry into a B-spline curve. B-spline curves are typically easier to use during surface modeling creation than analytic elements. For example, suppose you create a model with surfaces defined with analytic elements. You can use this command to convert the analytic elements to B-spline curve to obtain the control provided by B-spline curves.

**Why convert?**

- Analytical elements are often utilized as cross-sections and guide paths during surface creation. The resulting surface has inherent limitations on how it can be edited, as lines remain linear and arcs retain their circular definition.

- Curves provide more control, therefore are easier to use.

- Increased control facilitates edits.
  - Allows modification of a curve’s properties.
  - Defaults to a degree of 2. You can increase the degree and add edit points for more control.

- Once converted, curve shapes will have greater control over associated complex surfaces.
  - Simplifies the manipulation of a model from initial concept through final production.

- Can be used on the following analytics:
  - Single non-connected analytic element: conversion results in a single non-connected bspline curve.

- Multiple connected analytic elements.
  - Non-tangent elements: conversion results in multiple connected b-spline curves with no cusps.
  - Tangent elements: conversion results in multiple connected and tangent b-spline curves.

**Note**

You cannot convert B-spline curves to analytic geometry.
Note
You can only convert analytics to curves while in the Edit Profile mode.

(1) Analytic line and arc element
(2) Analytic elements converted to curves
(3) Curve edits
Activity: Drawing and editing a curve

Overview

In this activity, you learn to use the curve creation tools. Curves are the backbone for creating and controlling surface shape.

Objectives

After completing this activity you will be able to:

• Create curves.

• Edit curves.

• Analyze curves.

Turn to Appendix A for the activity.
BlueDot command (ordered modeling)

Note

BlueDots are only available in the ordered modeling environment

A BlueDot is a control point where two curves or analytics connect, or where one curve and one analytic connect, thereby providing a control point between the curves. It is a point which can edited to suit design or styling needs.

Creates a control point (1) between two sketch elements. You can connect the elements at their keypoints or at a point along the elements. The BlueDot overrides any existing associativity of the elements. This allows you to edit the location of the BlueDot or the elements it connects without regard to the order in which the elements were constructed.

After you connect the keypoints of two elements with a BlueDot, you can edit the position of the BlueDot to change the shape of the elements. Surfaces that were constructed using the elements also update.

Refer to Connect sketch elements with a BlueDot for more info on BlueDot creation.

Edit a BlueDot

To edit the position of a BlueDot, use the Select Tool to select a BlueDot (1), then click the Dynamic Edit button on the Select Tool command bar. When you edit the position of a BlueDot, you can use the OrientXpres tool (2) to restrict the movement to be parallel to a particular axis or plane. You can then drag the BlueDot to a new position (3). The wireframe elements and the surface also update.
When you use OrientXpres to restrict movement to a plane (1), you can move the BlueDot along two axes simultaneously (2).

You can also reposition the OrientXpres tool by selecting the origin of the X, Y, and Z axes, and then dragging OrientXpres to a new position.

You can use the BlueDot Edit command bar to specify whether the edit value is relative to its current position or its absolute position with respect to the global origin of the document. The global origin is the point where the three default reference planes intersect (the exact center of the design space).
When you apply a BlueDot to b-spline curves, you can also control how the curves react to the edit by setting options on the Curve 1 and Curve 2 controls on the command bar.

**Note**
When you use a BlueDot to connect two elements, it affects the associative relationship of the reference planes on which the elements lie. For example, if one of the elements lies on a reference plane that was created parallel to another reference plane, the dimensional offset value for the reference plane is deleted. When you edit the position of the BlueDot, the reference plane can be moved to a new position to facilitate the repositioning of the elements.

Refer to BlueDot Edit command bar for more information.

**BlueDots in Harness Design**

When working in Harness Design, you cannot use the command to connect sketch elements. However, the command allows you to connect the endpoints of two or more wire paths to create a single path.

![Diagram of BlueDot in Harness Design](image)

**Note**
When editing a BlueDot in Harness Design, the Curve 1 and Curve 2 options are not displayed on the BlueDot Edit command bar since you can connect more than two curves.

**BlueDot Edit command bar (ordered modeling)**

**Note**
BlueDots are only available in the ordered modeling environment.
Relative/Absolute Position
Specifies whether the value you type is relative to the BlueDot’s current position or is based on the global origin of the document. The global origin is the point where the three default reference planes intersect (the exact center of the design space).

X
Sets the position for the x axis.

Y
Sets the position for the y axis.

Z
Sets the position for the z axis.

Curve 1
Specifies the edit method you want for curve 1. This option is only available for b-spline curves. When you edit the position of a BlueDot that connects a curve to another element, you can set the following options to control how the curve is modified.

  Shape Edit—Affects the shape of the entire curve when you move a point on the curve.

  Local Edit—Affects the shape of a limited portion of the curve around the edit point.

  Rigid—Prevents the curve from being modified.

  Note
  This option is not available in Wire Harness.

Curve 2
Specifies the edit method you want for curve 2. This option is only available for b-spline curves. This option is not available when editing BlueDots in Wire Harness. When you edit the position of a BlueDot that connects a curve to another element, you can set the following options to control how the curve is modified.

  Shape Edit—Affects the shape of the entire curve when you move a point on the curve.

  Local Edit—Affects the shape of a limited portion of the curve around the edit point.

  Rigid—Prevents the curve from being modified.

  Note
  This option is not available in Wire Harness.
Connect sketch elements with a BlueDot

1. Choose Surfacing tab→Surfaces group→BlueDot.
2. Select a keypoint on the first element.
3. Select a keypoint on the second element.

**Note**
The first curve will move to intersect the second curve. Also, the shape and location of the first curve may change, but the second curve will maintain its initial shape and location.

**Tip**
- Each curve has four select zones: two endpoints, a midpoint and the curve itself.
- You can also use a BlueDot to connect elements at a point along the elements.
- You can edit the position of a BlueDot using the Select Tool and the BlueDot Edit command bar.
- You can use the OrientXpres tool to limit the edit to be parallel an axis or plane you select.
- When using the BlueDot command in Wire Harness, you can connect the end point of more than two harness elements.
Activity: Creating and editing BlueDots

Overview

In this activity you learn to manually create and edit BlueDots.

Objectives

After completing this activity you will be able to:

- Create BlueDots.
- Edit BlueDots and curves based on them.

Turn to Appendix B for the activity.
Lesson 3  

Creating and editing curves

Lesson review

Answer the following questions:

1. What is an edit point on a curve?

2. How do you display the control polygon of a curve?

3. Explain the differences in Shape Edit, Local Edit, and Rigid when moving a point on the curve.

4. How do you change the degree of a curve?

5. Explain what a BlueDot is and what impact it has on curves.

6. How do you convert analytics to B-splines?

7. What is the Curvature Comb used for?

8. On the BlueDot command bar, what does the Relative/Absolute Position option do?

Answers
Answers

1. What is an edit point on a curve?
   Edit points are handles that you can drag to change the shape of the curve.

2. How do you display the control polygon of a curve?
   Select the Show Polygon button on the Curve command bar.

3. Explain the differences in Shape Edit, Local Edit, and Rigid when moving a point on a curve.
   Shape Edit affects the shape of the entire curve; Local Edit affects just the area immediately around the edit point; Rigid prevents a change in the curve shape.

4. How do you change the degree of a curve?
   You can enter a value between 2 and 10 in the Degree field in the Curve Options dialog box.

5. Explain what a BlueDot is and what impact it has on curves.
   A BlueDot is a control point where two curves or analytics connect, or where one curve and one analytic connect, thereby providing a control point between the curves.

6. How do you convert analytics to B-splines?
   Use the Convert to Curve command.

7. What is the Curvature Comb used for?
   This helps you determine how quickly or gradually curves change and where they change direction.

8. On the BlueDot command bar, what does the Relative/Absolute Position option do?
   Specifies whether the movement value you type is relative to the BlueDot current position or is based on the global origin of the document.
Lesson 3  \textit{Creating and editing curves}

Lesson summary

Surface shapes are directly tied to the curves defining those surfaces. Therefore, the control of curves is crucial in modifying surface topology.

A curve:

- Can be edited by moving its edit points and control points.
- Can be further controlled by increasing its degree.
- Can be drawn directly by first defining edit points. Direct methods include:
  - Curve
  - Curve by table
  - Contour curve

- Can be created indirectly from existing curves and surfaces, making them dependent on underlying parent curves and surfaces. As the parent changes, so do the indirect curves.

Indirect curve methods are covered in the next chapter.
Lesson

4  *Indirect curve creation techniques*

**Objectives**

After completing this lesson, you will be able to:

• Use the following commands to create curves derived from other geometry:
  – Project curves
  – Intersection curves
  – Cross curves
  – Contour curves
  – Derived curves
  – Offset edge
  – Split curves
  – Keypoint curves
  – Curve by table

• Define and edit pierce and silhouette points.

• Draw curves overtop of a raster image.
Additional curve creation methods

Project Curve command

Projects one or more curves (2D or 3D) onto a surface or set of surfaces. You can project the curve along a vector or along surface normals. You can also use this command to project a point onto a surface.

You can use the command bar to specify that you want to project a single element, a chain of elements, a point, or an entire sketch.

You can select wireframe elements from multiple Parasolid bodies and the elements will remain associative.

Note

When projecting a curve onto a cylinder, make sure that the curve’s endpoints do not lie on a silhouette edge of the cylinder when viewed from the projection plane normal. Extend the edges of the curve past the cylinder edge.

Project curve options dialog box

Project Curve Options dialog box

Along Vector
Specifies that the curve or point be projected along a vector you define.

Normal to Selected Surface
Specifies that the curve or point be projected along surface normals.
Indirect curve creation techniques
Lesson 4  Indirect curve creation techniques

**Intersection Curve command**

Creates an associative curve at the intersection of two sets of surfaces. The surface sets can be any combination of reference planes, model faces, or construction surfaces.

An intersection curve is associative to the surfaces it is based on, so the curve updates if either set of surfaces changes.

For example, you can intersect a cylinder (A) with a reference plane (B). The resulting intersection curve (C) can then be used as input for constructing a feature or in a surface trimming operation.
Cross Curve command

Creates a 3-D curve at the intersection of two curves.

- The command works much like the Intersection Curve command, yet it does not need existing surfaces to create a curve.
- The only input required is two curves/analytics or a combination of the two.
- An intersection curve is created with the theoretical extruded surfaces resulting from the two input curves or analytics.

(1) and (2) are the input curves. (3) and (4) are the theoretical extruded surfaces. (5) is the resultant cross curve.
Lesson 4  
*Indirect curve creation techniques*

**Cross Curve command bar**

**Main Steps**

- **Curve 1 Step**
  Defines the first set of curves to be intersected.

- **Draw Curve 1 Step**
  Allows you to edit the profile for an existing feature. A profile is a 2D curve that defines the shape and location of the feature. The Draw Curve 1 Step is available only when you are editing an existing feature.

- **Curve 2 Step**
  Defines the second set of surfaces to be intersected.

- **Draw Curve 2 Step**
  Allows you to edit the profile for an existing feature. A profile is a 2D curve that defines the shape and location of the feature. The Draw Curve 2 Step is available only when you are editing an existing feature.

- **Preview/Finish/Cancel**
  This button changes function as you move through the feature construction process. The Preview button shows what the constructed feature will look like, based on the input provided in the other steps. The Finish button constructs the feature. After previewing or finishing the feature, you can...
edit it by re-selecting the appropriate step on the command bar. The Cancel button discards all input and exits the command.

Curve 1 and Curve 2 Step Options
Create-From Options
Sets the method of defining the profile plane or specifies that you want to construct the feature using an existing sketch. Depending on the model you are constructing, some of the options listed may not be available. For example, if no sketches exist in the model, the Select From Sketch option is not displayed.

- Select From Sketch—Specifies that you want to define the profile for the feature using an existing sketch.
- Coincident Plane—Specifies that you want to define a plane that is coincident to an existing reference plane or a planar face on the part. When you set this option, a default X-axis and direction is applied to the new reference plane. You can use keyboard accelerators to define a different X-axis and direction for the new reference plane.
- Parallel Plane—Specifies that you want to define a plane that is parallel to an existing reference plane or a planar face on the part. When you set this option, you can specify the parallel offset distance. When you set this option, a default X-axis and direction is applied to the new reference plane. You can use keyboard accelerators to define a different X-axis and direction for the new reference plane.
- Angled Plane—Specifies that you want to define a plane that is at an angle to an existing reference plane or planar face on the part. When you set this option, you can specify the angle value you want.
- Perpendicular Plane—Specifies that you want to define a plane that is perpendicular to an existing reference plane or planar face on the part.
- Coincident Plane By Axis—Specifies that you want to define a plane that is coincident to an existing reference plane or a planar face on the part. When you set this option, you define the X-axis and direction for the new reference plane using a linear edge, a planar face, or another reference plane.
- Plane Normal to Curve—Specifies that you want to define a plane that is perpendicular to a curve you select. This is the default option when constructing a helix using the Perpendicular option.
- Plane By 3 Points—Specifies that you want to define a plane by three keypoints you select.
- Feature’s Plane—Specifies that you want to define a plane that is coincident to a reference plane used to define an earlier feature. You can select the feature you want using Feature PathFinder or in the graphic window. This option is not available when constructing the base feature.
Lesson 4  Indirect curve creation techniques

- Last Plane—Automatically selects the reference plane used for the previous feature. This option is not available if the last feature was a pattern or when constructing the base feature.

Select From Sketch Options
  Select
  Sets the method of selecting a sketch element.
  - Single—Allows you to select one or more individual elements.
  - Chain—Allows you to select a endpoint connected set of elements by selecting one of the elements in the chain.

Deselect (x)
Clears the selection.
Accept (check mark)
Accepts the selection.

Other command bar Options
Name
Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

Commands
- Cross Curve command

Procedures
- Construct a 3D intersection curve
Contour Curve command

Draws a curve directly on a surface.

You can then use the curve for such things as a border in trimming operations

or as a tangent hold line in rounding operations.

You can select a single face or multiple faces when defining the faces on which you want to draw the curve. You can only draw within the bounded region and the curve will only lie within the bounded region. Curves that fall off the surface or surfaces or traverse trimmed regions are trimmed.

When defining the points for the curve you can use existing points that define the surface, such as vertexes, line midpoints, and edges of the surface.

You can add and delete points for the curve to follow and you can drag the points anywhere on the surface.

Tips for creation and manipulation of contour curves.

• Choose Contour command bar→Draw Points step→Insert Point to insert additional points into the curve. To delete a point from the curve, hold the SHIFT button and click on the point or click the right mouse button on the point.
Lesson 4  

*Indirect curve creation techniques*

- You can connect a keypoint and an existing keypoint. To do this, right-click the existing keypoint and select *Connect*; follow the prompts to identify the other keypoint.

- You can delete the connect relationships on a keypoint so that you can drag the keypoint on a face. To delete the relationship, right click the relationship and follow the prompts.

- You can drag an existing point to a new location on the face.

- When drawing a curve across faces that are not tangent, you must place a point at the shared edge.

*Contour Curve command bar*

**Contour Curve command bar**

- **Steps**
  - Select Surface Step
  - Defines the surface on which you want to draw the curve.

- Draw Points Step
  - Defines the points for the curve to follow.

- **Finish/Cancel**
  - This button changes function as you move through the feature construction process. The Finish button constructs the feature. After finishing the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards all input and exits the command.

- **Selecting a Surface**
  - Select
  - Sets the method of selecting an element.

  - Single—Allows you to select a single face.

  - Chain—Allows you to select a chain of faces.

- Deselect (x)
  - Clears the selection.

- Accept (check mark)
  - Accepts the selected sketch.

- **Drawing a Curve**
  - Open
  - Specifies that the curve will be open.
Indirect curve creation techniques

Close
Specifies that the curve will be closed. If a closed curve extends past the surface boundary, it is trimmed back to the surface boundary.

Insert Point
Inserts a point into the curve.

Select
Sets the method of selecting an element.
- Face—Allows you to select points on a face to draw the curve.
- Edge—Allows you to select points on an edge to draw the curve.
- Keypoints—Allows you to select keypoints on a face to draw the curve.

Other command bar Options
Name
Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

Commands
- Contour Curve command

Procedures
- Construct a contour curve
Derived Curve command

Constructs a new curve that is derived from one or more input curves or edges. If all the input curves or edges are connected at their endpoints, you can specify that the derived curve is constructed as a single b-spline curve. If the input curves are connected, but not tangent, the output curve will have a minimal amount of curvature added so that a single, smooth b-spline curve is constructed.

You can construct a single derived curve from multiple bodies. For example, you can construct a derived curve from a sketch (A), edges on a construction surface (B), and edges on a solid (C).

For more information on options, refer to Derived Curve command bar.

Derived Curve command bar

Main Steps
Select Curve Step
Allows you to select the curves or edges that define the new curve you want. You can select one or more curves or edges.

Finish/Cancel
This button changes function as you move through the feature construction process. The Finish button constructs the feature using input provided in the other steps. Once you construct the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards any input and exits the command.

Selecting a Curve Options
Single Curve
Specifies that the output curve is single curve. If all the input curves are connected at their endpoints, a single b-spline curve is constructed. When this option is cleared, the derived curve is comprised of multiple elements. If the input curves are connected, but not tangent, the output curve will have a
minimal amount of curvature added so that a single, smooth b-spline curve is constructed.

Select
Sets the method of selecting the elements that define the derived curve.
- Single—Allows you to select one or more individual elements.
- Chain—Allows you to select a endpoint connected set of elements by selecting one of the elements in the chain.

Deselect (x)
Clears the selection.

Accept (check mark)
Accepts the selection.

Other command bar Options
Name
Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

Commands
- Derived Curve command

Procedures
- Derive a curve

Offset Edge command
Offsets the selected edges to create an imprint of them on a part or surface by a given distance and direction. You can use this command in synchronous and ordered environments in part and sheet metal models.

Eligible selected edges must form a closed loop on the same plane, or a tangentially continuous chain of edges that do not lie on a planar face. You can select multiple edges from the same solid or surface, or edges across multiple solids and surfaces.
- A closed loop that is tangentially connected:

- A closed loop that is not tangentially connected:
For finite element analysis models that contain representations of bolts, you can use the Offset Edge command to produce better meshing results around bolt holes. In this application, the command generates offset faces to represent where each bolt, nut, and washer come in contact with a hole. This produces more nodes for the spider mesh to connect to and a better representation of the bolt.

**Note**

You can use the Derived Curve command to produce a new curve that is derived from one or more input curves.
Split Curve command

Splits a construction curve. You can select keypoints, curves, reference planes, or surfaces as the elements which split the curve.

Splitting a construction curve can make it easier to construct other features, such as a bounded surface, a trimmed surface, a normal protrusion, or a normal cutout.

Note
You cannot use the Split Curve command to split an edge on a model. You can use the Derived Curve command to create an associative copy of an edge on the model, then use the Split Curve command to split the derived curve.

Split Curve command bar

Main Steps
Select Curves Step
Allows you to select the construction curves which you want to split.

Select Splitting Elements Step
Allows you to select the elements which intersect the curve you want to split. You can use the Select option to define the elements which split the curve.

Finish/Cancel
This button changes function as you move through the feature construction process. The Finish button constructs the feature using input provided in the other steps. After you construct the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards any input and exits the command.

Select Set Options
Select
Sets the element type that you want to select. You can select the element type you want from the list. This option acts as a filter to make it easier to select the element you want.

- Single—Allows you to select one or more individual elements.
- Chain—Allows you to select a endpoint connected set of elements by selecting one of the elements in the chain.
• Feature—Allows you to select a feature.

• Body—Allows you to select a design body. This option is not available in the Select Curves Step.

Deselect (x)
Clears the selection.

Accept (check mark)
Accepts the selection.

Other command bar Options
Name
Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

Commands
• Split Curve command

Procedures
• Split a curve
Keypoint Curve command

Creates a 3-D curve through a set of three or more points. The points can be points you create with the Point command, keypoints on wireframe elements and edges, or points in free space.

You can use this command to create a bridge curve (A), which can be used as a path for a swept feature (B).

When you select a keypoint on a wireframe element or edge as the endpoint (C) of the curve, the End Conditions Step allows you to specify whether the curve is created tangent to the wireframe element or edge you selected. When you specify that the curve is tangent to an element at its endpoint, you can also modify the magnitude of the tangent vector by dragging the tangent vector handle (D) to a new location. When you modify the magnitude of the tangent vector, you also may change the radius of curvature of the curve. If the modified curve was used as a path for a swept feature, the swept feature will also update.
You can use the OrientXpres tool to help you define the location of a point on a keypoint curve. For example, you can use OrientXpres to lock input to a particular axis or plane when creating or editing a keypoint curve.

**Inserting points to a curve**

You can add new points along a curve or add a point in free space to add a new segment to the end of the curve.

To add a point along a path, while editing the curve, hold the ALT key and click the location along the curve where you want to add the point.

To add a point to the end of the path, while editing the curve, hold the ALT key and click a location in free space where you want to add the point.

**Removing points from a curve**

You can remove a point from a curve.

To remove a point, while editing the curve, hold the ALT key and click the point you want to remove. When you remove edit points, the control vertex points move and the shape of the curve changes.
If you remove the start or end point of a curve, the path truncates to the next control on the curve and the tangency of the next point remains the same.
**Curve By Table command**

Uses an Excel spreadsheet to define a construction curve. The spreadsheet, which is embedded in the Solid Edge document, allows you to better import and manage engineered curves. You can generate a curve by creating a new spreadsheet or by opening an existing spreadsheet. For example, you can create two helix curves using a spreadsheet with the Curve By Table command. You can then use these curves as paths to construct swept protrusions.

Note

Note: To create a curve using the Curve By Table command, or to edit an existing curve, Microsoft Excel must be loaded on your machine.
Activity: Creating keypoint curves

Overview
In this activity, you learn to create a keypoint curve. A keypoint curve is a 3D curve. The curve is defined by connecting to keypoints from existing geometry.

Objectives
After completing this activity you will be able to:
• Create a keypoint curve.
• Modify tangency vectors.

Turn to Appendix C for the activity.
Lesson 4  
*Indirect curve creation techniques*

**Activity: Additional curve creation methods**

![Image of a 3D model with curves]

**Overview**

In this activity, you will learn additional methods of creating curves. So far, you have learned to draw curves directly, point by point. Now you will learn to create curves indirectly, by combining inputs from existing curves and surfaces.

**Objectives**

After completing this activity you will know how to use:

- Intersection curves
- Cross curves
- Projected curves
- Contour curves
- Derived curves
- Split curves

Turn to Appendix D for the activity.

**Pierce points**

A *pierce point* is the point of intersection between a profile element and the active sketch plane.

**Example**

You can use a connect relationship to position the element you are drawing to where a profile element on another reference plane pierces the current profile plane.
Pierce points:
- Are extremely valuable in aligning curves.
- Recognize where a 3D curve, a sketch, or an edge passes through (pierces) the active profile plane.
- Connect geometry to curves intersecting a profile plane.
- Are useful for creating guide paths for BlueSurf and Sweep operations.

**Silhouette points**

*Silhouette points* are keypoints that occur on an arc, circle, or ellipse.

**Example**

When you draw a new line, you can touch the silhouette point on a circle. When you click, the new line is connected to the silhouette point on the existing circle.

Silhouette points:
- Are defined relative to the horizontal and vertical axis of the draft sheet or profile/sketch plane.
- Constitute any point where a plane parallel to the base reference plane passes tangent to a given curve.
- Can be used to connect dimensions.
- Act like endpoints.

---

**Insert Image command**
Lesson 4  

Indirect curve creation techniques

Inserts an image into a document. You can insert these types of files:

- Windows bitmap image file (.bmp)
- JPEG image file (.jpg)
- TIFF image file (.tif)

You can either link or embed the image, and you can control its display, including height, width, and aspect ratio.

In draft documents, another way to insert an image into documents is to drag it from your desktop or copy and paste it from an external application, such as Microsoft Paint. Pictures inserted in this manner are created as image objects rather than as symbols.

Inserted images can contribute to your modeling workflow in several ways. For example, you can sketch geometry over an image to create features based on it. Or you can use an image as a label or decal on a plane or planar face in the model.

Insert Image dialog box

Insert Image command bar

Insert Image dialog box

The Insert Image dialog box is displayed when you insert an image into a document. This dialog box changes name to Image Properties when you click an existing image or picture in the document.

Tabs

General Tab

Border Tab

Insert Image command bar

Width
Sets the width of the image.

Height
Sets the height of the image.

Angle
Sets the orientation angle of the image. Zero degrees is horizontal to the x axis. The angle increases in the counterclockwise direction.

Image Properties
Displays the Image Properties dialog box for you to change image border and other properties.

Flip Horizontal
Flips the image horizontally, such that the left side of the image is displayed on the right and vice versa.
Indirect curve creation techniques

Flip Vertical
Flips the image vertically, such that the top of the image is displayed on the bottom and vice versa.

Lock Aspect Ratio
Locks the aspect ratio of the image so that when you manipulate its dimensions, it scales proportionally.

Reset Aspect Ratio
Resets the aspect ratio to the image’s original proportions.

Toggle Border Display
Displays/hides the image border.

Commands
• Insert Image Command

Procedures
• Insert an Image
Points, curves (and surfaces) as construction elements

For some model types, you may not use the solid modeling commands until very late in the modeling process. Complex, freeform parts often require that you begin the modeling process by defining points and curves, which are used to define and control the surfaces that comprise the model. Surfaces are then generated, and in the final steps, the surfaces are stitched together to form a solid model.

- These construction element types can be created within Part, Sheet Metal, and Profile or Sketch environments:
  - Points
  - Curves
  - Surfaces

Construction elements that drive other features have a parent-child relationship with the features they drive. If you delete a construction element that is a parent to another feature, you can invalidate the other feature.

Displaying construction elements

- Use the View tab→Show group→Construction Display command to control display.

- Construction elements are listed in the Feature PathFinder.

  Note
  When hidden, a construction element entry in PathFinder changes to indicate that it is hidden.

- Color control is available for construction elements using either of the following:
  - The View tab→Color Manager command
  - The Colors tab in the Solid Edge Options dialog box.

- Specific display considerations:
  - Construction elements used to create new features are not consumed by the new feature, and are hidden by default.
  - It can be useful to hide the design body while you are working with construction surfaces. Under View tab→Show group→Construction Display, use either the Show Design Body or Hide Design Body commands.

Methods of creating construction elements

- Use existing geometry on the model. Intersection curves, Keypoint curves, Derived curves, Project curves, Split curves, and relevant point creation commands can be used.

- Create construction elements from scratch using the Solid Edge construction surface creation commands (extruded, revolved, and swept surfaces).
Indirect curve creation techniques

- Use Curve By Table to generate a curve based on input points.
- Use an external file. For example, you can create a helix curve using coordinate data in a spreadsheet.
- Import them from another CAD system. For example, you can import surfaces and solids from a third-party CAD system.
- Generate them as a part copy from another Solid Edge part. For example, you can create construction geometry using the Part Copy command on the Insert menu.

Using construction elements

- Points can be used in several ways:
  - To create other features:
    - Use a construction point or curve as a path or cross section for lofted and swept features.
    - Use the Intersection command to create cross sections for lofted features.
  - To define the extents of another feature:
    - Use keypoints of construction curves to define the extent for a feature.
    - Use the Intersection command to create associative points as input to define the extents of a feature.

- Curves can be used in two distinct ways:
  - Curves can be used to create other features, such as:
    - Paths and cross sections for lofted and swept features using Intersection curves, Keypoint curves and Derived curves.
    - Profiles for profile-based features using the Project Curve (useful for creating embossed text on a curved surface) and Split Curve (divide one into multiple curves to create a normal protrusion) commands.
    - Construction surfaces—the Split curve command can divide one construction surface into multiple curves to create a surface by boundary.
  - Use a construction curve as input to the Reference Plane Normal To Curve command.
Surfaces can be used as well; creation methods are covered in other training modules. Some general uses of surfaces are:

- To define the projection extents when extruding a feature. For example, a construction surface can be used as input during the Extent step when constructing a protrusion.

- To replace existing part faces.

- To divide a part into multiple parts.

- To create a new surface or solid by stitching together separate surfaces. Use the Offset Surfaces command to offset a new surface.

- To repair a model imported from a third-party CAD system.

- Construction surfaces are commonly used as projection extents when extruding a feature.
Lesson review

Answer the following questions:

1. How do you get tangency control on a keypoint curve?

2. Intersection curves are considered to be associative. What does this mean?

3. From what types of elements can a derived curve be formed?

4. Generally, why would you define construction elements (curves and points) as a first step?

Answers

Answer the following questions:

1. How do you get tangency control on a keypoint curve?
   
   The End Conditions Step specifies whether the curve is created tangent to a wireframe element or an edge you selected.

2. Intersection curves are considered to be associative to the parent surface sets. What does this mean?
   
   The curve changes shape if either set of surfaces changes.

3. From what types of elements can a derived curve be formed?
   
   You can construct a single derived curve from a sketch, edges on a construction surface, and edges on a solid.

4. Generally, why would you define construction elements (curves and points) as a first step?
   
   Complex, freeform parts often require that you begin the modeling process by creating points and curves that are used to define and control the surfaces that comprise the model. Surfaces are then generated, and in the final steps, the surfaces are stitched together to form a solid model.

Lesson summary

- You can create various curves indirectly from existing curves and surfaces. These curves are controlled by the parent curves and surfaces. As the parents change, so do the indirect curves.

- Surface shapes are directly tied to the curves defining those surfaces. Therefore, the control of curves is crucial in modifying surface topology.

- Pierce and silhouette points can assist in connecting curves to off-plane geometry.
Lesson

5 Surface creation

Objectives

After completing this lesson, you will be able to:

• Create simple surfaces.

• Create a BlueSurf.

• Edit a BlueSurf.

• Create a Bounded surface.
Overview of surfaces

A surface is a 3D element that is controlled by curves. Surfaces have no thickness and therefore can be visualized as a thin sheet. The complexity of a surface is directly proportional to the number of curves used to define it. A small, underlying curve set produces a relatively simple surface, while a complex face consists of a large number of curves. In Solid Edge modeling, a surface consists of cross-sections and guide curves. Guide curves may be preexisting or interpolated from the cross-section elements.

Curves form the mathematical basis of a surface. As your understanding of how to control curves increases, your mastery of surfaces grows.

There are two basic ways curve manipulation affect an associated surface:

1. Editing underlying cross-sections and guide curves directly modifies surface shape.

2. A surface can be trimmed and extended using curves and edges.

Once its shape is finalized, a surface can be used in the creation of additional faces via the following commands (covered in Lesson 5):

- Offset
- Copy
- Mirror

A surface also can be stitched together with other faces to form a solid, or it can include rounds between adjoining surfaces.
Creating a simple surface

The two most basic surface creation techniques utilize the **Extruded Surface** command.

![Extruded Surface](image1)

and **Revolved Surface** commands.

![Revolved Surface](image2)

**Extruded Surface command**

Creates a construction surface by projecting a profile along a straight line. Options are available to control the extents of the surface.
When you create an extruded surface using a closed profile, you can use the Open Ends and Close Ends options on the command bar to specify whether the ends of the surface are open (A) or closed (B). When you set the Close Ends option, planar faces are added to the ends of the feature to create a closed volume.

When constructing extruded surface features, you can also apply draft angle or crowning to the faces on the feature that are defined by profile elements. For more information, see the Applying Draft Angle and Crowning to Features Help topic.

**Revolved Surface command**

Creates a construction surface by revolving a profile around an axis of revolution.
When you create a revolved surface using a closed profile that is revolved less than 360 degrees, you can use the Open Ends and Close Ends options on the command bar to specify whether the ends of the surface are open (A) or closed (B). When you set the Close Ends option, planar faces are added to the ends of the feature to create a closed volume.
Lesson 5  Surface creation

Activity: Creating and editing simple surfaces

In this activity, you will learn to create and edit simple surfaces. You will use sketches in a training file to create an extruded surface and a revolved surface. After completing the surface, you will edit the sketch curve to observe the surface shape changes.

Objectives

After completing this activity you will be able to:

- Create and edit an extruded surface.
- Create and edit a revolved surface.

Turn to Appendix E for the activity.

Using simple surfaces as construction surfaces

Creating simple construction surfaces — Besides representing a very simple method of creating needed faces, the extruded and revolved surface commands can be used to build construction surfaces necessary for generating intersection curves with other faces. In this situation, the surfaces can be hidden after the operation is complete. This is preferred to deleting the faces, because they are the parents of the intersection curves.

Deleting construction surfaces — If you need to delete a surface, and if that face has children (the intersection curve, possibly others), use the Drop Parents command to permit the curves to remain after the surface is removed. However, those curves are no longer associated, and cannot be edited. Therefore, caution is advised when using Drop Parents.

To hide the display of surfaces, right-click in the part window and choose Hide All→Surfaces.
Tear-Off Sketch

Typical surface design methodology creates several curves on three base planes. As new planes are created, adding and copying profiles can be tedious, if not impossible. The **Tear-Off Sketch** command provides a clear modeling advantage in that it:

- Transfers or copies sketches from one plane onto another.
- Quickly creates new cross sections without having to define a plane and include geometry.
- Replicates sketches quickly for use in swept or lofted protrusions.
- Creates new sketches which are parallel or perpendicular, along curves, angular associative, copied or moved.

**Tear-Off Sketch command**

Copies or moves sketch and layout elements from one reference plane to another. This allows you to divide a large sketch into a series of smaller sketches, which can make it easier to complete the part or assembly you are documenting. For example, you can associatively copy a single sketch to a series of sketches using reference planes normal to a curve.

You can then use the resulting sketches as cross sections for constructing a feature such as a swept surface.

You can use the Tear-Off Sketch Options dialog box to:

- Copy sketch elements associatively
- Copy sketch elements non-associatively
- Move sketch elements
When you copy sketch elements associatively, a special symbol (A) is added to the copied sketch elements to indicate that the copied elements are associatively linked to the original sketch elements. If you modify the original elements, the associative elements also update.

When selecting the sketch to tear off, you can select a single sketch element or a chain of sketch elements. You can only tear off sketch elements within the same sketch. If you select multiple sketch elements, all the elements are copied or moved either associatively or non-associatively. You cannot copy some of the elements associatively and some of them non-associatively.

After you copy or move the elements to the new sketch, you can use the Reposition button on the Tear-Off Sketch command bar to connect keypoints of an element profile to a pierce point that passes through the target reference plane. In the Assembly environment, the pierce point option is not available.

You can connect multiple keypoints on a torn off sketch to multiple keypoints. For example, you can connect keypoints on a sketch to multiple guide curves. You have to select the Reposition button for each new position definition.

Tear-Off Sketch command bar

Tear-Off Sketch Options dialog box
**Swept Surface command**

Constructs a surface by extruding one or more cross sections (A) along a path you define (B).

You can define up to three paths and many cross sections. After you define the third path, the command automatically proceeds to the cross section step.

The cross sections can be open or closed and can be planar or non-planar. You can place them anywhere along the path. For predictable results, it is best if the cross sections intersect all paths. The sweep paths can be either tangent or non-tangent.

When you create a swept surface using a closed sketch, you can use the Open Ends and Close Ends options on the command bar to specify whether the ends of the swept surface are open or closed. When you set the Close Ends option, faces are added to the ends of the feature to create a closed volume.

You can select wireframe elements from multiple Parasolid bodies or sketches and the elements will remain associative.

**Sweep Options dialog box**

- **Sweep Type**
  - Single Path and Cross Section
    - Specifies that you want to use a single path and single cross section to create the swept feature.
    - The path and cross section can be open or closed.
Lesson 5  

Surface creation

Note

You can use the command bar to modify an existing single path and single cross section swept feature to add more paths or cross sections. For example, to add a cross section, select the feature, go to the Cross Section Step, then click the Plane or Sketch Step button. To add more cross sections, you can then select a reference plane, sketch elements, or model edges.

Multiple Paths and Cross Sections

Specifies that you want to use multiple paths and cross sections to create the swept feature. You can use up to three path curves and many cross sections.

• After you define one or two paths, click the Next button on the ribbon bar to proceed to the cross-section step.

• The cross sections can exist anywhere along the path, be all open or all closed and can be planar or non-planar.

• A sweep path can consist of either tangent or non-tangent elements.

• If you define a third path, the command automatically proceeds to the cross-section step.

Note

You cannot mix open and closed cross-sections.

Part and Sheet Metal Dialog Box Options

The following dialog box options are available only when constructing swept features in the Part and Sheet Metal environments.

Section Alignment

Specifies how the cross section profiles are oriented with respect to the path curves.

Normal

Specifies that the cross section profiles maintain a fixed relationship with the normal plane of the path curve.
Parallel
Specifies that the cross section profiles maintain a constant and parallel orientation to the cross section profile plane.

Parametric
Varies the orientation of the cross section profiles so that points on the path curves are matched according to the proportional parameter distance of the underlying path curve. This option is only available when two or more path curves are defined.

Each path curve must be a single element. If the path curves you are using have more than one element, you can use the Single Curve option available with the Derived Curve command to create a single element path curve, or you can set the Arc Length option, described below.

This option can be useful when constructing swept features with two path curves and one cross section and you want the feature to extend to the end of both path curves. Notice the Parametric option (A) extends to the ends of both path curves, where the Normal option (B) stops short of the end of one of the path curves.

Arc Length
Varies the orientation of the cross section profiles so that points on the path curves are matched according to the proportional arc-length distance along the path curves. This option is only available when two or more path curves are defined. You can use path curves that consist of a single element or multiple elements.

This option can be useful when constructing swept features with two path curves and one cross section and you want the feature to extend to the end
of both path curves. Notice the Arc Length option (A) extends to the ends of both path curves, where the Normal option (B) stops short of the end of one of the path curves.

Face Continuity
Specifies the degree of face continuity required where adjacent segments within a swept feature meet.

- **Tangent Continuous**
  Specifies that adjacent sweep segments are tangent and continuous, but are not required to have the same radius of curvature.

- **Curvature Continuous**
  Specifies that adjacent sweep segments are tangent, continuous, and have the same radius of curvature. This imparts extra smoothness to the surfaces and can be important when creating aesthetic surfaces.

Face Merging
Specifies the face merging option you want. If you change the face merging options on a swept feature after downstream features that depend on the original faces are constructed, the downstream features may not recompute properly.

The example illustrates no merge (A), full merge (B), and merge along path (C). Part Painter was used to change the surface color.
No Merge  
Does not merge the output faces.

Full Merge  
Merges as many faces as possible, given the input geometry.

Along Path  
Merges as many faces as possible along the path direction only, given the input geometry.

Scale  
Constructs the swept feature by scaling the cross section curve along the path curve. These options are available only for single path and cross section sweeps after you select the path and cross section curves. You can specify a scale value for each end of the feature.

If you specify a scale value greater than 1, the swept feature is increased in size at the specified end of the feature. If you specify a scale value less than 1, the swept feature is decreased in size at the specified end of the feature. If you specify a scale value of 1, no scale is applied to the specified end of the feature.

The examples below illustrate (A): no scale, (B): start scale of 1 and an end scale of 1.5, (C): start scale of 0.5 and an end scale of 1.5.
Lesson 5  
*Ssurface creation*

Scale Along Path
Specifies that you want to scale the cross section along the path curve.

Start Scale
Specifies the start scale value.

End Scale
Specifies the end scale value.

Twist
Constructs the swept feature by twisting the cross section profile around the path curve. These options are available only for single path and cross section sweeps after you select the path and cross section curves.

If you specify a number greater than zero, the twist is applied in a clockwise fashion from the start point of the path curve. If you specify a number less than zero, the twist is applied in a counter-clockwise fashion from the start point of the path curve. If you specify zero, no twist is applied.

None
Specifies that no twist is applied to the feature.

Number of Turns
Applies twist to the feature by specifying the number of turns the cross section is twisted along the entire path curve. The examples below illustrate (A): no twist, (B): 0.25 turns, (C): −0.25 turns.

![Illustration of twist examples](image)

Turns per Length
Applies twist to the feature by specifying the number of turns the cross section is twisted per unit of length of the path curve. The examples below illustrate (A): no twist, (B): 0.10 turns per 42 millimeters of path curve, (C): −0.10 turns per 42 millimeters of path curve. The overall length of the example path curve is approximately 84 millimeters.
Angle
Applies twist to the feature by specifying the degrees of twist at the path start and end points. The examples below illustrate (A): no twist, (B): zero twist at start point and 90 degrees twist at end point, (C): zero degrees twist at start point and –90 degrees twist at end point.

Start Angle
Specifies the start twist value.

End Angle
Specifies the end twist value.

Note
You can also combine scale and twist options. The examples below illustrate the different results possible when using (A): scale, (B): twist, (C): scale and twist.
Show This Dialog When The Command Begins
Displays the dialog box every time you select the command. If you do not want to display the dialog box when you select the command, clear this option.

Additional options — More options exist for Sweep.
When you create a swept surface using a closed profile, you can use the Open Ends and Close Ends options on the Swept command bar to specify whether the ends of the swept surface are open or closed.
When you set the Close Ends option, faces are added to the ends of the feature to create a closed volume.
Activity: Creating a swept surface

Overview
In this activity, you will learn to create and edit a swept surface. You will use provided sketches to create a swept surface. After completing the surface, you will edit the sketch path and cross sections to observe the surface shape changes.

Objectives
After completing this activity you will be able to create and edit a swept surface.

Turn to Appendix F for the activity.
Lofted Surface command (ordered modeling)

Creates a construction surface by fitting through a series of profiles.

- Cross sections can be defined by drawing a profile, selecting existing sketch elements or selecting edges of surfaces.
- You can also use a guide curve to define a path between the cross sections of the loft.
- The end condition, or Extent, options allow you to control the shape of the loft feature where it meets the first and last cross sections.
- The loft feature is associative to the input elements, regardless of the element type you use to define the cross sections and guide curves.
- When you create a lofted surface using a closed profile you can use the Open Ends and Close Ends options on the command bar to specify whether the ends of the surface are open or closed. When you set the Close Ends option, planar faces are added to the ends of the feature to create a closed volume.

Note

You can select wireframe elements from multiple Parasolid bodies or sketches and the elements will remain associative.
Note

While in Ordered modeling, the Lofted Surface icon may need to be added to the command ribbon. Search Solid Edge help for the phrase “Customize the command ribbon” to learn more about including any missing command, such as lofted surface.

Note

Tips

• If you use sketches, you can only select elements from one sketch for each cross section.

• You cannot combine elements from a sketch with edges to define a cross section.

• When working with loft features that have many cross sections and guide curves, you should consider drawing sketches first, rather than drawing the profiles as you construct the feature. This approach can make it easier to construct and edit the feature.
Bounded Surface command

Creates a construction surface using boundary elements you define. The boundary elements can be curves or edges and they must define a closed area (A). You can also specify whether any adjacent faces (B) are used to control tangency on the new bounded surface (C).

- The curve/edge set must form a closed loop.
- Adjacent faces can be used to control tangency on the new bounded surface.
- The preparation of edges/curves to be utilized may require the use of the derived curve and split curve commands.
- The keypoint curve command can be used to generate a boundary curve.
BlueSurf

Note

Please refer to the Help topics *BlueSurf command* and *BlueSurf Options dialog box* for more detailed information.

BlueSurf is a surface creation command used to generate complex, but highly editable surfaces. Like loft and sweep, a BlueSurf utilizes cross sections and guide curves, and these parent curves drive the behavior of the resultant surface. Several techniques can be applied to further edit a BlueSurf.

- New section and/or guides can be incorporated, providing additional control over the BlueSurf topology.

- As sections and/or guides are added, the number of edit points can be increased or reduced through the concept called Edit Point Data Management.

- BlueDot edit points can be moved in order to manipulate the surface; both Shape and Local Edits are available.
Lesson 5  Surface creation

The first step in creating a BlueSurf is selecting cross sections. The Cross Section Step activates automatically. At least two cross sections are required.

Next, you can select guide curves if needed. Click the Guide Curve Step and select the guide curve(s).

Click Preview and then Finish.

The example below shows the BlueSurf result of two cross-sections (C1, C2) and two guide curves (G1, G2).

A BlueSurf may also consist of a single cross-section and a single guide curve. The following example shows the BlueSurf result of using cross-section (C1) and guide curve (G1) from the previous example.
At this point, editing any of the cross-sections or guide curves modifies the shape of the BlueSurf. If you need additional surface shape control, the BlueSurf command provides a step to insert additional sketches.

**BlueSurf command**

Constructs a surface using existing sketches or part edges. You can use the BlueSurf command to construct complex surfaces that provide many editing options.

**Input requirements**

The sketches or edges can represent cross sections only (A) or cross sections (A) and guide curves (B). At a minimum, you must define two cross sections or one cross section and one guide curve.

The sketches or part edges can be open or closed.

**Mixing open and closed elements**

When constructing a bluesurf feature, you can use both open and closed elements in a single feature. For example, you can construct a bluesurf feature that uses a line and a closed element, such as a rectangle or a circle, as cross sections. In some situations, you may need to split elements or define vertex mapping parameters to construct the surface you want. For example, to construct a BlueSurf feature using a line and a circle, you must split the circle into two arcs. You can use the Split command to split the circle into two connected arcs.
Closing ends

When you create a BlueSurf feature using closed cross sections, you can use the End Capping options on the BlueSurf Options dialog box to specify whether the ends of the feature are left open (A) or closed (B). When you set the Close Ends option, a solid body is created.

Inserting sketches

You can use the Insert Sketch Step on the command bar to add new sketches to a BlueSurf feature. The geometry for the new sketch is created by intersecting a reference plane you define with the BlueSurf feature. You do not have to create the sketch geometry yourself. When you insert a sketch, the new geometry is created as a b-spline curve. If you want the new geometry to consist of lines, arcs, or circles, you must create the new sketch manually outside of the BlueSurf command.

When you click the Insert Sketch button on the command bar, plane creation options are added to the command bar so you can define the position for the new reference plane. For example, you can use the Parallel Plane option to define an offset reference plane where you want additional control over the resultant surface.
You can then edit the sketch to change the surface shape.

When you add a cross section or guide curve to an existing BlueSurf feature using the Insert Sketch option, the new sketch is connected to the cross sections or guide curves. You can use the BlueSurf Options dialog box to specify whether Pierce Points or BlueDots are used to connect new section to the surface.

**Note**

BlueDots are only available in the ordered modeling environment

**Pierce points**

When you set the Use Pierce Points option, connect relationships are used to tie the inserted sketch to the cross sections or guide curves it intersects. When you set the Use BlueDots option, BlueDot elements are used to tie the inserted sketch to the cross sections or guide curves it intersects. The option you specify also affects how you can edit the feature later.

When you connect the new sketch using the Use Pierce Points option, you can modify the cross sections or guide curves the new sketch intersects and the b-spline curve for the inserted sketch will update. The Use Pierce Points option is most suitable for models that must conform to engineering data or dimension-driven criteria; such as turbine blades, fan housings, and so forth. The Use Pierce Points options maintains the existing parent/child history of the model.

**BlueDots**

If you are working with a BlueSurf in the ordered environment, and you insert a sketch using the Use BlueDots option, you can also modify the BlueSurf feature by editing the position of the BlueDots using the Select Tool and the BlueDot Edit command bar. When you move a BlueDot, the portion of the sketches that are controlled by the BlueDot update, and that portion of the BlueSurf also updates.

The Use BlueDots option is most suitable for ordered models that are driven by esthetic requirements, such as consumer electronics products, bottle and container design, and so forth. When you use BlueDots to connect an inserted sketch, moving a BlueDot can also change the location of the reference planes of the sketches it connects.

This is because a BlueDot allows you to override the existing parent/child history of the model. For example, if you insert a sketch using a parallel reference plane with an offset value of 25 millimeters, editing the location of the BlueDot can also change the offset value of the reference plane.
Lesson 5  

Surface creation

This behavior can be preferable when exploring the esthetic possibilities of a surface, but can be counter-productive when working with engineered surfaces. In some cases, using BlueDots can also cause a model to take longer to update, because moving a BlueDot may require more of the model to recompute than a connect relationship would.

Note

When you set the Use BlueDots option on the BlueSurf Options dialog box, but existing constraints prevent BlueDots from being created, then pierce points are created instead.

Refer to Inserting sketches into a BlueSurf for the process of inserting sketches.

Creating new sketches manually (ordered modeling)

Alternately, you can also create new sketches for a BlueSurf feature using the Sketch command, or you can copy an existing sketch using the Tear-Off Sketch command. You can then edit the BlueSurf feature and add the new sketches as cross sections or guide curves.

For example, when you add new cross sections, the system adds them after the existing cross sections, regardless of their physical orientation with respect to the existing cross sections. You can use the Reorder option on the Advanced tab on the BlueSurf Options dialog box to define the cross section sequence.

Cross section and guide curve connectivity

If you use a guide curve to construct a BlueSurf feature, the guide curve must intersect each cross section and be tangent continuous (the curve cannot have any sharp corners). To ensure that the guide curve stays intersected to the cross sections, you should add a connect relationship or a BlueDot at each intersection point.

End condition control

You can use the Tangency Control options on the BlueSurf Options dialog box to define the end condition options you want for the resultant surface. For example, you can specify that the surface is tangent to the adjacent surfaces.

Many of the end condition options allow you to dynamically adjust the surface using a graphic handle (A) or by modifying a variable in the variable table. For surfaces that have several graphic handles or variables for a single cross section, you can create a master variable for all the variables that control the cross section, then use a formula to drive all the variables for that cross section simultaneously.
BlueSurf features and lofted features

In many respects, a BlueSurf feature is constructed and behaves similarly to a lofted feature, such as a lofted surface or a lofted protrusion. For example, you can reorder cross sections, define vertex mapping rules, and define the end section conditions for a BlueSurf feature and a lofted feature.

BlueSurf Options Dialog Box

Standard Tab Options
Tangency Control

Specifies the options you want for controlling the shape at the ends of the feature. For example, when you are creating a BlueSurf feature that must blend smoothly with adjacent surfaces, you can set the Normal to Section option to ensure a smooth blend between the existing surfaces.

The following options are available, depending on the geometry you select for the cross section or guide curve:

- Natural—There are no constraining condition enforced at the end sections. This is the default end condition and is valid for any cross section type.

- Normal to Section—End cross sections that are planar support a normal to section end condition. You can control the length of the vector using the variable table or by modifying the vector handle in the graphic window. In this example, the resultant surface illustrates the graphic handles (A) that you can use to modify the surface.
• Parallel to Section—End cross sections that are planar support a parallel to section end condition. You can control the length of the vector using the variable table or by modifying the vector handle in the graphic window. To see the effect of this setting, compare the following illustration of Parallel to Section with the Normal to Section example.

• Tangent Interior—End cross sections defined using part edges and construction surfaces support a tangent interior condition. Tangent Interior forces the surface to be tangent to the inside faces. For example, the surface below has the Tangent Continuous option applied to cross section (A), and the Tangent Interior option applied to cross section (B). The resulting surface is constructed tangent to the planar face (C).

• Tangent Continuous—End cross sections defined using part edges and construction curves support a tangent condition. The tangent vector for the surface is determined by the adjacent surfaces. You can control the length of the vector using the variable table or by modifying the vector handle in the graphic window.
Curvature Continuous—End cross sections defined using part edges and construction surfaces support a curvature continuous condition. The tangent vector for the surface is determined by the adjacent surfaces. You can control the length of the vector using the variable table or by modifying the vector handle in the graphic window.

For more information and illustrations which show you how you can control the surface shape at the ends of BlueSurf and lofted features, see the End Conditions section in the Constructing Lofted Features Help topic.

Start Section
Specifies the tangency control option you want for the first cross section.

End Section
Specifies the tangency control option you want for the last cross section.

Edge Guide 1
Specifies the tangency control option you want for the first guide curve. The options available for defining guide curve tangency conditions depend on the type of element you select for the guide curve. For example, if you want to be able to control the tangency of the BlueSurf feature with respect to an adjacent surface, use an edge on the surface as the guide curve rather than, for example, the sketch that was used to construct the adjacent surface.

Edge Guide 2
Specifies the tangency control option you want for the last guide curve. The options available for defining guide curve tangency conditions depend on the type of element you select for the guide curve. For example, if you want to be able to control the tangency of the BlueSurf feature with respect to an adjacent surface, use an edge on the surface as the guide curve rather than, for example, the sketch that was used to construct the adjacent surface.
Lesson 5    

_Surface creation_

End Capping
Specifies the end capping options you want. This option is available only when the cross section profiles are closed.

- **Open Ends**
  Specifies that no planar end caps are added to the feature.

- **Close Ends**
  Specifies that planar end caps are added to the feature to create a enclosed volume.

Extent type
Controls whether or not the feature closes on itself.

- **Open**
  Specifies that the feature begins with the first cross section and ends with the last cross section. The feature does not close on itself.

- **Closed**
  Specifies that the surface will close on itself. When you set this option, the first cross section is also used for the last cross section.

Curve Connectivity
Specifies how a cross section and a guide curve are connected. These options only apply to new sketches you add using the Insert sketch button on the command bar.

- **Use Pierce Points**
  Specifies that a connect relationship is used to connect the cross section and guide curve where they intersect. The position of the connect relationship is calculated using the Pierce Point option on the IntelliSketch dialog box. The Use Pierce Points option is typically used when constructing engineered surfaces, such as the surfaces for a fan or turbine blade, where engineering data or dimension-driven criteria must be maintained.

- **Use BlueDots**
  Specifies that a BlueDot is used to connect the cross section and guide curve where they intersect. When you connect a cross section and a guide curve with a BlueDot, you can use the BlueDot as a handle to dynamically modify the shape of the cross section and guide curve. The Use BlueDots option is typically used when constructing esthetic surfaces, such as the surfaces for consumer electronics product, where a more free-form approach to surface design is desired.

  **Note**
  The Use BlueDots option is available only in the ordered modeling environment. The BlueDots functionality is not available in the synchronous environment.

Inserted-Sketch
Allows you to define a tolerance value for sketches you insert. The tolerance value you specify is used to control the complexity of the curve that is created.
Surface creation

Tolerance
Specifies the tolerance value you want to use.

Advanced Tab Options

Vertex Mapping
Vertex mapping is a technique to help create flow between section vertices; you can map a vertex or point on one cross section to a vertex or point on another cross section. Vertex mapping is useful for controlling or eliminating twists and discontinuities in a surface. If there is a vertex count mismatch between sections, equally spaced vertices are used on each section.

You can add vertex maps while creating a BlueSurf or by editing an existing BlueSurf.

Notice in the first image below that section (A) has four vertices and section (B) has three vertices. The BlueSurf command automatically inserts vertices equally spaced on each section. Notice the surface flow is not smooth.

The result of vertex mapping.

Map Sets
Lists the sets of mapped vertices you have defined. You can add vertex map sets to create a smooth surface flow; to add a new set of mapped vertices, click the Add button, then click a point on each cross section curve.

Add
Allows you to add a new mapped vertex set.
Lesson 5  Surface creation

Delete
Allows you to add a delete an existing mapped vertex set.

Reorder
Allows you to reorder cross sections that were defined out-of-sequence. This option is useful when you modify an existing feature by adding a new cross section. You cannot use the re-ordering capability to create a feature that intersects itself.

To reorder a cross section, select the cross section in the list, then click the Up or Down buttons to move the cross section entry in the list.

Inserting sketches into a BlueSurf

Note
In the following example, the Use BlueDots option is used for curve connectivity.

Inserting a sketch.

Step 1: On the BlueSurf command bar, click the Insert Sketch Step. You must select a plane to insert a sketch on. All of the plane creation methods are available.

In the following example, the parallel plane option was selected. Reference plane (A) was selected as the plane to be parallel to. Reference
plane (B) can be dynamically dragged to the location to insert a sketch. You can also key in a distance. Click location to insert a sketch (C).

**Step 2:** Insert a sketch (C) in the guide curve direction and notice the results. The parallel plane is used again.
**Step 3:** Now turn off the reference planes and observe the results.
When the guide curve direction sketch was inserted, it crossed another sketch. The BlueSurf command automatically inserts BlueDots at the intersection of the curves. If there were several sketches in the cross-section direction, the inserted sketch in the guide curve direction would be connected with BlueDots.

**Adding cross sections into a BlueSurf (ordered modeling)**

Any cross section sketch created after the BlueSurf is created will not be seen by the BlueSurf feature. When you edit a BlueSurf created in the ordered modeling environment, it only recognizes sketches created before it was created.

**How to add a new cross section.**

**Step 1:** The BlueSurf feature below was created with two cross sections (C1, C2). First, add a new cross section (C3) that was created before the BlueSurf feature.

**Step 2:** Click the Select Tool and then select the BlueSurf feature. On the ribbon bar, click Edit Definition.
Lesson 5  
Surface creation

Step 3: On the BlueSurf commandbar, click the Cross Section Step.

Step 4: Identify the new cross section (C3). Notice that cross section C3 is placed last in the cross section order, which causes the BlueSurf feature to reverse direction. The cross section order below is C1, C2 and then C3. You can reorder the cross sections to make C3 be defined between C1 and C2.

Step 5: On the BlueSurf command bar, click the options button. Click the Advanced tab.

Cross section C3 is shown as Section 3. To reorder C3 to be between C1 and C2, click Section 3 and then click Up. Click OK to apply the reorder.
The following shows the result with cross-sections ordered C1, C2 and C3.

Adding cross sections created after the BlueSurf feature

If you create a cross section (A) after the BlueSurf feature (B), the cross section will have to be moved up in the feature tree to be recognized by the BlueSurf feature.
Lesson 5  

To move the cross section up in the feature tree, click the Select tool. In PathFinder, click and hold the Blue Surf and drag it below the latest sketch as shown.

The sketch can now be seen by the BlueSurf feature.

**Vertex mapping**

Vertex mapping is a technique to help create flow between section vertices. If there is a vertex count mismatch between sections, equally spaced vertices are used on each section.

Notice in the image below that section (A) has four vertices and section (B) has three vertices. The BlueSurf command automatically inserts vertices equally spaced on each section. Notice the surface flow is not smooth.

You can add vertex map sets to create a smooth surface flow. You can add vertex maps while creating a BlueSurf or by editing an existing BlueSurf.
On the BlueSurf command bar, click the Options button. On the BlueSurf Options dialog box, click the Advanced tab.

Click Add and then select two vertices to be mapped together as shown.
Lesson 5  

*Surface creation*

Click Add again and select the next two vertices to be mapped together as shown.

Click OK in the dialog box and then Finish. The result is shown below.

**BlueSurf command bar**

Main Steps
Cross Section Step
Defines the cross sections to which the feature will be fitted. You can define any number of cross sections for a BlueSurf feature, using any combination of cross sections created from sketches and cross sections created from part edges.

Guide Curve Step
Defines the guide curve for the feature to follow. To be valid, guide curves must touch each cross section.

Insert Sketch Step
Allows you to insert a sketch as a new cross section or guide curve. Inserting sketches between existing cross sections or guide curves can give you more localized control over the resulting surface. When you click the Insert Sketch button, the Defining a Plane options are displayed, so you can dynamically define a new reference plane. When you click to define the position for the new reference plane, Solid Edge creates the sketch by intersecting the reference plane with the current surface. The inserted sketch is created as a b-spline curve and is connected to the existing cross sections or guides curves using BlueDots.
Surface creation

(ordered environment only) or connect relationships, depending on the options you set on the BlueSurf Options dialog box.

Preview/Finish/Cancel
This button changes function as you move through the feature construction process. The Preview button shows what the constructed feature will look like, based on the input provided in the other steps. The Finish button constructs the feature. After previewing or finishing the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards all input and exits the command.

Cross Section Step Options
Select
Sets the edge selection method for defining the cross sections. You can use any combination of selection methods to select a set of edges. Hold the CTRL key or the SHIFT key to de-select an edge.

- Sketch/Chain—Allows you to select a sketch or a tangentially continuous chain of edges.
- Single—Allows you to select a single edge or sketch element.
- Face—Allows you to select all the edges of a face by selecting the face.
Lesson 5  \textit{Surface creation}

- Loop—Allows you to select all the edges of individual loops of a face by selecting the face and then choosing a loop.

Deselect (x)
Clears any selected edges and the edge selection criteria.

Accept (check mark)
Accepts the edge selection criteria and selects all edges that meet the criteria. You can also accept the selection by clicking the right mouse button or pressing the ENTER key.

Guide Curve Step Options
Select
Sets the edge selection method for defining the cross sections. You can use any combination of selection methods to select a set of edges. Hold the CTRL key or the SHIFT key to de-select an edge.

- Chain—Allows you to select a sketch or a tangentially continuous chain of edges.

- Single—Allows you to select a single edge or sketch element.

- Face—Allows you to select all the edges of a face by selecting the face.

- Loop—Allows you to select all the edges of individual loops of a face by selecting the face and then choosing a loop.

Deselect (x)
Clears any selected edges and the edge selection criteria.

Accept (check mark)
Accepts the edge selection criteria and selects all edges that meet the criteria.

Insert Sketch Step Options
Plane Options
Sets the method of defining the plane for the inserted sketch. Depending on the model you are constructing, some of the options listed may not be available.

- Coincident—Specifies that you want to define a plane that is coincident to an existing reference plane or a planar face on the part. When you set this option, a default X-axis and direction is applied to the new reference plane. You can use keyboard accelerators to define a different X-axis and direction for the new reference plane.

- Parallel—Specifies that you want to define a plane that is parallel to an existing reference plane or a planar face on the part. When you set this option, you can specify the parallel offset distance. When you set this option, a default X-axis and direction is applied to the new reference plane. You can use keyboard accelerators to define a different X-axis and direction for the new reference plane.

- Angular—Specifies that you want to define a plane that is at an angle to an existing reference plane or planar face on the part. When you set this option, you can specify the angle value you want.
Surface creation

- Perpendicular—Specifies that you want to define a plane that is perpendicular to an existing reference plane or planar face on the part.

- Coincident Plane By Axis—Specifies that you want to define a plane that is coincident to an existing reference plane or a planar face on the part. When you set this option, you define the X-axis and direction for the new reference plane using a linear edge, a planar face, or another reference plane.

- Plane Normal to Curve—Specifies that you want to define a draft plane that is perpendicular to a curve you select.

- Plane By 3 Points—Specifies that you want to define a plane that is defined by three keypoints you select.

- Feature’s Plane—Specifies that you want to define a plane that is coincident to a reference plane used to define an earlier feature. You can select the feature you want using Feature PathFinder or in the graphic window. This option is not available when constructing the base feature.

- Last Plane Used—Automatically selects the reference plane used for the previous feature. This option is not available if the last feature was a pattern.

Other command bar Options

BlueSurf Options Dialog Box

Displays the BlueSurf Options dialog box.

Name

Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

Activity: Creating a BlueSurf using analytics

Overview

In this activity, you learn to create a BlueSurf feature. You will use provided sketches to create a BlueSurf surface.

Objectives

After completing this activity you will be able to create a BlueSurf feature.
Lesson 5  

Surface creation

Turn to Appendix G for the activity.
Activity: Creating and editing a BlueSurf

Overview
In this activity, you will learn to create and edit a BlueSurf. You will use provided curve sketches to create a BlueSurf.

Objectives
After completing this activity you will be able to:

- Create a BlueSurf.
- Insert sketches.
- Edit BlueDots.
- Dynamically edit curves.

Turn to Appendix H for the activity.
Lesson review

Answer the following questions:

1. When do cross sections and guide curves have to be connected?
   The BlueSurf requires connectivity between cross sections and guide curves.

2. Name the two ways to edit a cross section or guide curve?
   Use the Add Cross Section step on the BlueSurf command bar.

3. How do you add more cross sections to a BlueSurf?
   Use the Add Guide Curve step on the BlueSurf command bar.

4. How do you add more guide curves to a BlueSurf?
   Select the Use BlueDots option on the Standard tab of the BlueSurf Options dialog.

5. What happens to inserted sketches on a BlueSurf when the BlueSurf is deleted?
   They are retained in the part history as a sketch.

6. How do you get BlueDots on inserted sketches on a BlueSurf?
   Right click in the view and select Hide All→BlueDots.

7. How do you turn off the display of BlueDots?

   **Answers**

Answers

1. When must cross sections and guide curves intersect?
   The BlueSurf requires connectivity between cross sections and guide curves.

2. How do you add more cross sections to a BlueSurf?
   Use the Add Cross Section step on the BlueSurf command bar.

3. How do you add more guide curves to a BlueSurf?
   Use the Add Guide Curve step on the BlueSurf command bar.

4. What happens to inserted sketches on a BlueSurf when the BlueSurf is deleted?
   They are retained in the part history as a sketch.

5. How do you get BlueDots on inserted sketches on a BlueSurf?
   Select the Use BlueDots option on the Standard tab of the BlueSurf Options dialog.

6. How do you turn off the display of BlueDots?
   Right click in the view and select Hide All→BlueDots.

Lesson summary

You control surfaces by curve definitions. You change the surface shape by editing the underlying curves. You edit curves using Dynamic Edit or by editing the curve sketch or profile.

The extruded and revolved surfaces creation methods work similarly to the solid protrusion and revolved protrusion commands. These surfaces are useful in the development of more complex surfaces.
BlueSurf provides you the same results of a swept or lofted surface. However, BlueSurf provides much more control and editing capability. You can add cross sections and guide curves. You can control tangency at the start and end cross sections. You can use BlueDots or Pierce points to connect the inserted cross section and guides. Editing the BlueDots gives you real-time surface shape updates as they are moved.

Bounded surfaces are used to fill in gaps in a model. A bounded surface is created by selecting edges (curves) that form a closed loop. You have the option to make the resulting surface tangent to adjacent surfaces.
Lesson

6  Surface manipulation tools

Objectives

After completing this lesson you will be able to use the surface manipulation commands:

• Extend Surface
• Offset Surface
• Copy Surface
• Trim Surface
• Delete Faces
• Stitched Surface
• Round
• Replace Face
• Parting Split
• Parting Surface
• Split Face
**Extend Surface command**

Extends a surface along one or more edges you select.

The edges you select can form a continuous chain (A) or be interrupted (B).

The extend options which are available depend on whether the surface is an analytic surface or a non-analytic surface. Examples of analytic surfaces include planes, partial cylinders, cones, spheres, and tori. You create non-analytic surfaces when you sweep or extrude a b-spline curve, or when you construct lofted, swept or BlueSurf feature using b-spline curves.

When extending a non-analytic surface, you can specify whether the extension is Natural, Linear, or Reflective along certain types of edges. For example, when extending an extruded surface constructed using a b-spline curve, you can specify the Natural Extend, Linear Extend, or Reflective Extend options for the two edges which are parallel to the input b-spline curve (A, B).

For the two edges which are perpendicular to the input b-spline curve (C, D), only the Natural Extend option is mathematically possible. In this example, the natural extension is linear.
Additional examples are illustrated in the Extend Surface command bar topic.

**Extend Surface command bar**

Main Steps
- Select Edges Step
  Defines the edge of the surface that you want to extend. You can select one or more edges.

- Extent Step
  Defines the distance you want to extend the surface. You can define the distance dynamically using the cursor or type a value.

Finish/Cancel
- This button changes function as you move through the feature construction process. The Finish button constructs the feature using input provided in the other steps. Once you construct the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards any input and exits the command.

Selecting Edges Options
- Natural Extent
  Specifies that the extended surface will continue the natural curvature of the input face. For example, if the input surface is linear with respect to the edge you select, the extension will be linear. If the input surface is radial with respect to the edge you select, the extension will be radial. If the input surface is based on a b-spline curve with respect to the edge you select, the extend feature is both tangent to and matches the radius of curvature of the existing surface.
Lesson 6  
*Surface manipulation tools*

Linear Extent
Specifies that the extended portion of the surface will be linear and tangent with respect to the input face. This option is not available for analytic surfaces.

Reflective Extent
Specifies that the extended portion of the surface will be a reflection of the input surface. This option is not available for analytic surfaces.

Select
Sets the method of selecting the edge you want to extend.
Surface manipulation tools

- **Edge**—Allows you to select an edge on the input surface.

- **Chain**—Allows you to select a set of edges by selecting one of the edges in the chain. To select a chain of edges, the edges must be tangent.

**Deselect (x)**
Clears the selection.

**Accept (check mark)**
Accepts the selection.

**Extent Step Options**
- **Distance**
  Sets the distance to extend the surface.

**Other command bar Options**
- **Name**
  Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.
Offset Surface command

Creates a construction surface by offsetting a model face, a reference plane, or another construction surface. The new surface is offset a specified distance from the original surface, and is associative to it.

If the face or surface has boundaries, Offset Surface has options to remove or keep the boundaries on the offset surface.

The following illustration shows an offset surface B offset in direction A with the show boundaries option on.
**Offset Surface command bar**

Main Steps
Select Step
Defines the surfaces that should be offset to create the offset surface.

Offset Step
Defines the offset distance and the side of the surfaces that should be offset.

Preview/Finish/Cancel
This button changes function as you move through the feature construction process. The Preview button shows what the constructed feature will look like, based on the input provided in the other steps. The Finish button constructs the feature. After previewing or finishing the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards all input and exits the command.

Select Step Options
Select
Sets the method of selecting faces to offset. You can use any combination of selection methods to select a set of faces. Hold the CTRL key to select more than one face at a time. Hold the SHIFT key to de-select an face.

- **Body**—Allows you to select the entire body, such as a surface body.
- **Single**—Allows you to select individual faces, or to select all faces adjacent to a corner by selecting the corner.
- **Chain**—Allows you to select tangentially continuous chains of faces.
- **Feature**—Allows you to select a feature, particularly stitched surfaces.

Deselect (x)
Clears the selection.

Accept (check mark)
Accepts the selection.

Offset Step Options
Distance
Sets the distance from the base element to the surface. If you enter a distance of zero, a zero dimension is placed for the offset.

Remove Boundaries
Removes internal boundaries of the surface.

Show Boundaries
Displays internal boundaries of the surface.
Lesson 6  

*Surface manipulation tools*

Other command bar Options
Name
Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

---

**User Interface**

- **Offset Surface command**

**Procedures**

- Construct an offset construction surface

---

**Copy Surface command bar**

---

**Main Steps**

Select Step
Allows you to select the input faces that define the new construction surfaces you want. You can select one or more faces.

Finish/Cancel
This button changes function as you move through the feature construction process. The Finish button constructs the feature using input provided in the other steps. Once you construct the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards any input and exits the command.

**Select Options**

Remove Internal Boundaries
Removes the internal boundaries on the new surfaces. Internal boundaries are typically areas that do not extend to the edge of a surface, such as a hole in the middle of a surface.

Remove External Boundaries
Removes the external boundaries on the new surfaces. External boundaries are typically areas that do extend to the edge of a surface, such as a cutout that removes a portion of the surface along its edge. You cannot remove external boundaries if any adjacent surfaces in the select set are stitched together.

Select
Sets the method of selecting the surfaces that you want to copy.
- **Body**— Allows you to select the entire body, such as a surface body.
- **Single**— Allows you to select individual faces.
- **Chain**— Allows you to select tangentially continuous chains of faces.
Surface manipulation tools

- Feature—Allows you to select all the faces of a feature by selecting the feature.

  Deselect (x)
  Clears the selection.

  Accept (check mark)
  Accepts the selection.

Other command bar Options

Name
Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

Copy Surface command

Creates a construction surface feature that is derived from one or more input faces. The faces you select do not need to be adjacent to each other. You can specify whether any internal or external boundaries are removed on the new copy of the surface.

The following illustration shows surface face A copied with boundaries removed B.
Trim Surface command

Trims one or more surfaces along the input element you define.

- You can use a curve, reference plane, or another surface as the input element.
  - If using curves,
    ◊ They must lie on the surface you are trimming; use the Project Curve command to project the curve onto the surface first.
    ◊ Closed curves that do not completely lie on the surface are not supported.
  - If using a curve or surface as the trimming element:
    ◊ If the curve or surface boundary does not extend to the edges of the target surface, the trim boundary element is extended linearly and tangent to the input element.
    ◊ For example, surface (B) is used to trim surface (A). Since surface (B) does not extend to the edges of surface (A), linear extensions are added to the trim boundary element (C). The input element you select as the trimming tool (B) is not modified.

When you use a curve as a trimming element and it does not lie on the surface you want to trim, you can use the Project Curve command to project the curve
onto the surface first. Closed curves that do not completely lie on the surface are not supported.
Delete Faces command

Deletes faces from the model.

You can use this command to do the following:

- To remove faces from a design model to make design changes.
- To simplify a model in the Simplify Model environment so that it processes faster when used in an assembly.
- To remove faces from a sheet metal part when working in the Flat pattern environment.
- To remove faces from a construction body.

When you delete a face on a part body, which must always be a solid body, the gap created by the deleted surface is automatically closed.

When you delete a face on a construction body, which is not required to be a solid body, you can specify whether the gap is closed or left open using the Heal option on the command bar.

When you clear the Heal option, the gap is not closed and you can construct another surface to close the gap. This can be useful when working with foreign data which cannot be converted into a solid body when you import it.
Stitched Surface command

Stitches together multiple, adjacent construction surfaces to form a single construction surface feature.

- This command is useful for joining imported surfaces.
- If the stitched surfaces form a closed volume, you have the option to designate the solid body as a base feature.
- You can set the stitched surface options for tolerance and surface healing on the Stitched Surface Options dialog box.
- Notice the default tolerance on the Stitched Surface Options dialog box. Once you turn on the Heal option, you can change this value if the edges of two surfaces being stitched together do not meet the default tolerance.

Tips:
- To remove surfaces from the select set, select the surfaces while pressing the SHIFT key.
- To delete the link between the stitched surface feature and its parents, use the Drop Parents command on the shortcut menu. This command reduces the amount of data in the file. Once you drop the parent information, the stitch surface feature can no longer be edited.
- You can use the commands on the shortcut menu to display, hide, edit, rename, or recompute the stitched surfaces.
- If the output forms a closed volume, a solid body will be created. Otherwise, the stitch surface will be a sheet body with free edges that can be stitched to other surfaces.
- If the stitched surfaces result in a solid body and there is no base feature in the file, the Make Base Feature command becomes available on the shortcut menu, and you can make the stitched body the base feature for the part.

To show the stitchable edges on construction surfaces, click Surfacing tab→Surfaces group→Show Non-Stitched Edges located on the list headed by the Stitched Surface command.
The illustration below shows the stitchable edges for surface A and surface B. Surfaces A and B were stitched together to produce C and the stitchable edges are shown.
Round

You can use the Round command to place fillets and rounds on surface edges or between two adjoining surfaces.

Blend command

Creates a variable radius round,

a blend between faces,
or a blend between surface bodies.

**Blend command bar**

- **Blend Type**
  - Variable: Specifies that the rounded edge can have a variable radius value. After you select the edges you want to round, you define the radius values you want in the Select Vertices Step by selecting vertices and keypoints and typing the radius value you want for that location.

- **Blend**: Species that the round will be a blend between two surfaces you select. If either of the selected surfaces are part of a tangentially connected chain of surfaces, the blend is applied to the chain of surfaces. You can only select faces that are part of a solid body when this option is set.
Surface Blend

Species that the round feature will be a blend between two surfaces you select. If either of the selected surfaces are part of a tangentially connected chain of surfaces, the blend is applied to the chain of surfaces. When this option is set, you can also specify whether you want to trim the input surfaces or the output surface blend using the Surface Blend Parameters dialog box. You can only select faces that are part of a surface body when this option is set.

Steps
Select Step
Selects the edges and faces to round or blend.

Select Vertices
For variable radius rounds only, specifies the vertexes for rounding.

Side Step
For surface blending only, specifies the side in which you want to apply the blend. You can use the cursor to position the arrow on the side which you want the blend.

Overflow Step
For blending only, specifies options for blend overflow.

Round Parameters
Displays the Round Parameters dialog box.

Surface Blend Parameters
Displays the Surface Blend Parameters dialog box so you can define the trim options you want. This option is available when you set the Surface Blend option on the Round Options dialog box.
Preview/Finish/Cancel
This button changes function as you move through the feature construction process. The Preview button shows what the constructed feature will look like, based on the input provided in the other steps. The Finish button constructs the feature. After previewing or finishing the feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel button discards all input and exits the command.

Command Bar Options
Select Step
Select
Sets the edge selection method for constructing a round feature. You can use any combination of selection methods to select a set of edges to round. Hold the Ctrl key to de-select an edge.

For variable rounds:
- Edge/Corner—Select individual edges, or to select all edges adjacent to a corner by selecting the corner.
- Chain—Select tangentially continuous chains of edges.
- Face—Select all the edges of a face by selecting the face.
- Loop—Select all the edges of individual loops of a face by selecting the face and then choosing a loop.
- Feature—Select all the edges of a feature by selecting the feature.
- All Fillets—Select all inward-facing edges of a part by selecting the part.
- All Rounds—Select all outward-facing edges of a part by selecting the part.

For blends and surface blends:
- Face—Select all the edges of a face by selecting the face.

Shape
Sets the cross sectional shape of the blend. This option is available when you set the Blend option. You can select from the following options:
- Constant Radius—Creates a constant radius circular cross section blend. When you set this option, you can use the Radius box to define the radius size you want.
- Constant Width—Creates a circular cross section blend with a constant chord width between the two selected faces. When you set this option, you can use the Width box to define the chord width you want.
- Chamfer—Creates a chamfer blend with equal setbacks. When you set this option, you can use the Setback box to define the setback value you want.
• Bevel—Creates a beveled blend using a value to control the amount of material that is removed from the adjacent faces. When you set this option, the Setback option specifies the size of the blend face, and the Value option determines how much material is removed from the adjacent faces. You can type a value that is greater than zero, but less than or equal to 10.0. A Value entry of 1.0 creates a 45 degree bevel.

• Conic—Creates a constant elliptical cross section blend. When you set this option, the Radius box defines the width of the cross section and the Value box changes the cross section shape. The value parameter specifies a ratio that offsets the blend radius between the first and second faces selected. For example, a radius of 50 with a value of 10 creates a blend with a radius of 500 at the point of tangency with the first face, ending with a radius of .5 at the point of tangency with the second face. Use a value of 1 to apply a constant radius value across the blend. Use a value greater than 1 to apply a greater radius value to the first face selected, and use a value less than 1 to apply a greater radius to the second face selected.

• Curvature Continuous—Controls the continuity, or softness, of the blend surface. When you set this option, the Radius box defines the radius of the cross section and the Value box is used to control the continuity of the surface between the walls, or the softness of the blend. A Value less than 1.0 creates a flatter, more chamfer-like cross-section. A Value greater than 1.0 appears to extend the selected surfaces and creates a smaller blend radius. Typical values can range from 0.0 to 10.0.

Value

**Note**

The Bevel, Conic and Curvature Continuous options all utilize the continuity Value.

When the Bevel option is set, you can use the Value to control the amount of material removed from the adjacent faces.

When the Conic option is set, you can use the Value option control the shape of the blend cross section.

When the Curvature Continuous option is set, you can use the Value option to control the shape of the blend cross section.
In the previous images, the continuity values are 0.5, 1.0 and 2.0 respectively.

**Radius**
Sets the radius for blends. You can type a radius value or select a preset value from the list.

**Width**
Specifies the width of the chord for the blend. This option is available when you set the Constant Width option for the blend shape.

**Setback**
Specifies the setback value for the blend. This option is available when you set the Chamfer option for the blend shape.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Specifies the linear length value for the blend. This option is available when you set the Bevel option for the blend shape.</td>
</tr>
<tr>
<td>Accept (check mark)</td>
<td>Accepts the edge selection criteria and selects all edges that meet the criteria.</td>
</tr>
<tr>
<td>Deselect (x)</td>
<td>Clears any selected edges and the edge selection criteria.</td>
</tr>
<tr>
<td>Overflow step</td>
<td>For blending only, modifies the blend to maintain selected edges or continuous blend across selected edges.</td>
</tr>
<tr>
<td>Roll Along/Across</td>
<td>For blending only, defines a tangent hold line for the blend. You can define a tangent hold line for each of the input faces or for only one of the input faces.</td>
</tr>
<tr>
<td>Tangent Hold Line</td>
<td>For blending only, maintains the default radius for the blend.</td>
</tr>
<tr>
<td>Default Radius</td>
<td>For blending only, varies the radius according to the tangent hold line.</td>
</tr>
<tr>
<td>Full Radius</td>
<td>For blending only, varies the radius according to the tangent hold line.</td>
</tr>
</tbody>
</table>

**Name**
Displays the feature name. Feature names are assigned automatically. You can edit the name by typing a new name in the box on the command bar or by selecting the feature and using the Rename command on the shortcut menu.

## Replace Face command

Replaces selected faces on a part. The replacement face can be a construction surface, a reference plane, or another face on the part. When replacing more than one face, the faces being replaced cannot touch each other.

When you replace a face using a construction surface, the construction surface is hidden automatically when you finish the feature.

If edges on the face you are replacing have rounds applied, the rounds are reapplied after you complete the replace face operation.
Activity: Surface manipulation

Overview
In this activity you will learn to use the surface manipulation commands.

Objectives
After completing this activity you will be able to:
• Extend a surface.
• Offset a surface.
• Trim a surface.
• Copy a surface.
• Delete faces of a surface.
• Stitch surfaces together.
• Round surfaces.
• Replace a face on a solid body.

Turn to Appendix I for the activity.
**Split Face Command**

Splits one or more surfaces (A) using an element (B) you define. You can select curves, edges, surfaces, reference planes, and design bodies as the elements that split the face.

Splitting a face can be useful when constructing a model that you want to use for finite element analysis purposes or when you want to isolate a portion of a face so you can to apply a decal or image in a specific location.

If the element you are using to define the split location does not extend to the boundary of the face you are splitting, the Split Face command will extend the imprinted splitting curve tangentially. The original element you selected is not extended. For example, if you split a face using a sketch that consists of a line and an arc, the imprinted curve is extended linearly and tangent to the original line and arc.

If the imprinted curves intersect when they are extended, the split face feature will not succeed.

When you use a surface as the splitting element, the surface must physically intersect the surface you want to split. When you use a reference plane as the splitting element, the reference plane must theoretically intersect the surface you want to split (the reference plane is considered to be infinite in size).

When you use curves or edges as the splitting elements, such as a sketch to split a face, the splitting elements must lie on the face you are splitting. You can use the Project Curve command to project the elements onto the 3-D face.
What can go wrong-split face features

This topic gives you solutions to problems you might have when constructing split face features.

Missing Parent

Target faces must be from the same body: When constructing split face features, the faces you want to split must be from the same body.

Targets and tools do not intersect. The splitting element does not intersect with the surfaces you want to split.
Parting Split command

Splits a set of faces along the silhouette edges of the part, which can be useful when working with a part that will be molded or cast. Parting lines are the same as silhouette lines for a given face. You define the vector direction for calculation of the parting lines by defining a reference plane (A). A parting split feature (B) is represented by curve.

To better illustrate the results, the surfaces which are split by the parting split feature are shown in green and gold below. The surfaces shown in gray were not split. Surfaces which do not cross the parting line and planar faces are not split by this command.
Parting Surface command

Constructs a parting surface along a parting curve you select. You construct a parting surface by selecting a reference plane (A) to define the orientation of the linear cross section curve, and a 2-D or 3-D parting curve (B), which defines the sweep path for the parting surface (C).

You create the parting curve in a separate operation. For example, you can use the Intersection Curve command or the Parting Split command to create the parting curve.
Activity: Parting split and parting surface

Overview
When you complete this activity, you will be able to use the Parting Split and Parting Surface commands.

Objectives
After completing this activity you will be able to use the following commands:

- Insert Part Copy
- Boolean
- Parting Split
- Parting Surface
- Divide Part

Turn to Appendix J for the activity.
Activity: Creating a rotary razor body

Overview
In this activity, you will utilize several surfacing techniques to create the body for a rotary razor.

Objectives
After completing this activity you will be familiar with:

- Curve creation and manipulation techniques.
- Extruding surfaces.
- Blue Surf generation.
- Creating bounded surfaces.
- Using the Parting Split command.
- Offsetting surfaces.
- Extending surfaces.
- Generating a thin-walled (plastic) part.
- Placing rounds.

Turn to Appendix K for the activity.
Activity: Putting it all together

Overview
In this activity, you will use the surfacing tools and workflows learned in this course to build a bathtub spout.

Objectives
After completing this activity you will be able to:

• Read a control drawing.

• Create and edit curves.

• Create and edit surfaces.

• Make a solid feature.

Turn to Appendix L for the activity.
Lesson review

Answer the following questions:

1. What are the three extent options available on the Extend Surface command bar?
   
   Natural, Linear and Reflective.

2. How do you create an offset surface without boundaries from an input surface that has boundaries?
   
   Use the “Remove Boundaries” option on the command bar.

3. Can you trim a surface with multiple open curves in one step?
   
   NO, only a single open curve can be selected for trimming.

4. Can you trim a surface with multiple closed curves in one step?
   
   YES, multiple closed curves can be selected for trimming.

5. How do you round a common edge of two separate surfaces?
   
   Use the Surface Blend type of Blend.

6. Can multiple faces of a solid be replaced in one step?
   
   YES. However, these faces cannot touch each other.

Answers

Lesson summary

Many tools exist to modify surfaces. These commands greatly increase your ability to create and control complex shapes.

After stitching surfaces together, Solid Edge automatically creates a solid body.

You can delete and replace faces as needed to optimize your design.

The Parting Split and Parting Surface commands facilitate the development of parts to be manufactured in molds or dies (often called plastic parts).
Lesson

7 Curve and surface inspection tools

Objectives

After completing this lesson, you will be able to:

• Understand and use curvature combs.
• Use Draft Face Analysis.
• Use Curvature Shading.
• Use Zebra Stripes.
Curvature Comb command

Toggles the display of the curvature comb for a curve. The value of the curvature is displayed when the cursor is over the curve. The value dynamically updates as you move the cursor along the curve.

Curvature combs help you determine how quickly or gradually curves change and where they change direction. You can use the curvature comb to quickly determine the feasibility of machining and to predict the aesthetic qualities of surfaces generated from a curve.

If you have a curvature comb displayed and use dynamic edit to make changes to the curve geometry, the comb updates immediately to reflect the changes.
Surface inspection tools

Surface inspection tools are available in the Inspect tab→Analyze group.

- Draft Face Analysis
- Curvature Shading
- Zebra Stripes
Draft Face Analysis command

Displays colors on the model based on the surface angles with respect to a draft plane you define. This allows you to visualize whether a part can be removed from a mold or die. To display draft face analysis colors, you must also shade the active window using the Shaded or Shaded With Visible Edges commands.

You can use the Draft Face Analysis Settings command to specify the draft plane, draft angle, and assign the colors you want to use.

Draft face analysis and view quality

The results of a draft face analysis depends on the current view quality. You might find that the draft face analysis result changes if you modify the view quality. For example, if you increase the view quality using the Sharpen command from 2 to 4, the results for the face shown in the illustration are changed from a crossover face (A) to a positive face (B).
Curvature Shading command

Displays colors on the model based on the radius of curvature of the model's surfaces. This allows you to graphically visualize the radius of curvature of a model. You must also shade the active window using the Shaded or Shaded With Visible Edges commands to display curvature shading colors.
Zebra Stripes command

Displays zebra stripes on the model. Zebra stripes are useful for visualizing the curvature of surfaces to determine if there are surface discontinuities and inflections.

**Note**

You must also shade the active window using the Shaded or Shaded With Visible Edges commands to display zebra stripes.

- Zebra Stripes are solid bands of color overlaid on top of a single face or set of surfaces:
  - Displayed at regular spacing, controlled by the user.
  - Follow the contour of the relevant faces.
- One might ask: “How do these ’stripes’ help?”
  - Smooth stripes are manifested by smooth, continuous surfaces (ie., no cusps or “wrinkles”).
  - Stripes with sharp bends would indicate abrupt changes in surface curvature (ie., a discontinuity).
  - Discontinuities will make manufacturing more difficult.
    - Metallic Parts: Machining will be more complex.
    - Molded Parts: Injection of plastic may be difficult into discontinuous areas.
  - You can control colors, spacing and the method of mapping the stripes using the Zebra Stripes Settings.

**Benefits**

- Striping gives quick indication of continuous edges between faces.
- Dynamic; users can see changes in real-time.
- Non-rollback edit method.
Lesson review

Answer the following questions:

1. What is the Curvature Comb used for?

2. In what situations would the Draft Face Analysis command be useful?

3. Explain the difference between Curvature Shading and Zebra Stripes.

Answers

Answer the following questions:

1. What is the Curvature Comb used for?

   Curvature combs help you determine how quickly or gradually curves change and where they change direction. You can use the curvature comb to quickly determine the feasibility of machining and to predict the aesthetic qualities of surfaces generated from a curve.

2. In what situations would the Draft Face Analysis command be useful?

   This tool allows you to visualize whether a part can be removed from a mold or die based on the surface angles with respect to a draft plane you define.

3. Explain the difference between Curvature Shading and Zebra Stripes.

   Curvature Shading provides you with coloration representing actual value ranges for a surface’s radius of curvature. Zebra Stripes provide more subjective visualization of a surface, allowing you to see areas of discontinuity, if present.

Lesson summary

You have learned what curvature combs show, and how to modify their output. Methods for visualizing the quality of surfaces have also been covered here.
A  Activity: Drawing and editing a curve

Open surface lab 2–01.par.

Draw a curve

Begin the activity by drawing a curve with edit points in space.

- Select Home tab→Sketch group→Sketch.
- Select the plane below.

- Click Home tab→Select group→Select.
Activity: Drawing and editing a curve

- In PathFinder, click the box next to Sketch A to show it. Use the sketch elements in Sketch A as a guide to where to place the edit points.

- Select Home tab→Draw group→Curve

- Click just above each of the construction points from left to right as shown. After clicking above the last point, select Close Sketch, then Finish on the command bar to create the curve.

Hide the sketch containing edit points

- Click Home tab→Select group→Select.
In PathFinder, click the box next to Sketch A to hide it.

![Image of a curve to be edited]

**Edit the curve shape**

- Select the curve, and on the command bar, choose *Edit Profile*. Select the curve again, and notice the display of the edit points and control polygon.

![Image showing edit points and control polygon]

Also, the Edit Curve command bar is displayed; on the command bar, the Local Edit option is on.

**Note**

With the Local Edit option, when you drag an edit point or control point, the shape of the curve changes near the point you drag. With Shape Edit, the entire curve changes shape slightly, preserving the overall shape of the curve.
Activity: Drawing and editing a curve

- With the Local Edit option selected, drag the edit point shown to observe how the curve shape changes.

- After editing the curve, on the Quick Access toolbar, click the Undo command. This returns the curve to its original shape.
Activity: Drawing and editing a curve

- Select the curve. On the Edit Curve command bar, select the Shape Edit option.

- With the Shape Edit option selected, drag the edit point shown and observe how the curve shape changes.

- After editing the curve, click the Undo command.

Add more control to the curve

- Select the curve. On the Edit Curve command bar, click the Curve Options button.
Activity: Drawing and editing a curve

- In the Curve Options dialog box, ensure the degree is set to 3 and click OK.

- On the Edit Curve command bar, click the Add/Remove Points button ▲.
Add edit points at the two locations shown below.

**Note**

You can only insert one edit point at a time with the Add/Remove Points button. You can either select the button again, or you can press and hold the Alt key while you click the curve to place as many points you need.

Edit the curves again to observe how the shape changes. Undo to return the curve to its original shape.
Activity: Drawing and editing a curve

- In the Curve Options dialog box, change the Degree from 3 to 5 and click OK. Observe the change to the control polygon.

- Edit the curve again with both Local Edit and Shape Edit options to see how the curve shape changes now with the higher degree. Be sure to undo any changes you make to the curve.

Local Edit
Inspect the curve using Curvature Comb

- Select the curve. On the Edit Curve command bar, select the *Show Curvature Comb* button.

**Note**

You can adjust the curvature comb display using the Curvature Comb Settings dialog box.
Activity: Drawing and editing a curve

- Select Inspect tab→Analyze group→Curvature Comb Settings.

![Curvature Comb Settings dialog box]

**Note**
Density controls the number of normal vectors. Magnitude controls the length of the vectors.

- Move the slider bars and observe the curvature comb display.

![Curvature Comb Settings dialog box with sliders adjusted]

- In the Curvature Comb Settings dialog box, clear the Show curvature combs box and click Close.

- Click Home tab→Close group→Close Sketch to complete the sketch.
Activity: Drawing and editing a curve

- On the Sketch command bar, select Finish.
- In PathFinder, clear the check box next to the sketch just completed to hide it.

Draw a curve connected to elements

- In PathFinder, check the box next to Sketch B to show it.
- Select Sketch B and click **Edit Profile**.
- Click Home tab→Draw group→Curve.
- Draw a curve with edit points at the endpoints of the lines (1-5) shown below. Make sure to get the endpoint connect symbol before clicking. After placing the last edit point, right-click to complete the curve.

![Endpoint Connect Symbol](image)

![Diagram of curve with edit points at endpoints](image)
Activity: Drawing and editing a curve

- Select the dimensions and edit their values as shown to observe how the curve is constrained to the dimensioned elements.

Constrain the curve

- Delete all elements in the sketch except for the curve.
Activity: Drawing and editing a curve

- Select the curve.
Activity: Drawing and editing a curve

- Click Home tab→Relate group→Horizontal/Vertical.

![Diagram showing points A and B](image)

**Note**

Notice that the edit points and control vertices display as crosses. If you position the cursor over a cross, you will see the following denoting if it is an edit point (A) or control vertex (B).

![Diagram showing edit points and control vertices](image)

Click point A and then click point B. Points A and B will always remain aligned horizontally.
Activity: Drawing and editing a curve

- Place a dimension as shown between the horizontal reference plane and edit point C.

- Place a dimension as shown between the horizontal reference plane and edit point A.
Activity: Drawing and editing a curve

- Add a vertical relationship between control vertex F and the center of the reference planes.

- Apply a final constraint to control vertices. Place two dimensions as shown between the vertical reference plane and control vertices D and E.

Note

More constraints are needed to make the curve symmetric about the vertical reference plane. For this activity stop adding constraints at this point.
Activity: Drawing and editing a curve

- Edit the dimensions as shown and observe the curve shape constraints.

- Drag control vertex F down and observe how the curve shape changes while maintaining the relationships you applied.

- Save and close the part file.
Summary

In this activity you learned how to draw and edit curves based on edit points and lines.
**B Activity: Creating and editing BlueDots**

Open *surface lab 2-02.par*.

*Note*
Curves must be connected in order to use them to create surfaces. Only the Swept Surface command does not require input curves to be connected. You will learn more about this in the next lesson.

*Note*
The order in which you select curves determines which curve will change location. The first curve you select will move to connect to the second curve. The first curve sketch plane will change to the connected location. The second curve you select does not change.

*Note*
There are several curve selection locations. See the topic on BlueDot Creation in the theory section of this lesson.
Use BlueDots to connect two curves

Experiment with connecting two curves using different selection locations. Remember to undo after each connection to return the curves to their original location.

- Click Surfacing tab→Surfaces group→BlueDot
- Select curve 1 at the location shown and then select curve 2 at the location shown. Notice the resulting connection and then click Undo.

Connect the four curves at the end points

After having experimented with different curve selection possibilities, connect the four curves at the end points.

- Click the BlueDot command and connect the curves in the sequence shown below (1-2, 3-4, 5-6, and 7-8).

Note
Make sure the endpoint connect symbol displays before you click.
Right-click to finish.

**Edit a BlueDot**

The four curves are now BlueDot connected. Edit a BlueDot to observe how the curves behave.

- Select the BlueDot shown. Use QuickPick as an aid to select it.

- On the command bar, select Dynamic Edit.
Click the Z-direction axis on the 3D triad as shown. This locks the BlueDot movement to the Z-direction.
Activity: Creating and editing BlueDots

- Edit the BlueDot by dragging it in the graphics window or by typing a new Z-coordinate value. Drag the BlueDot a small distance as shown and observe the behavior of the connected curves.

Note
Both curves are set to Local Edit.

- Click Undo to return the BlueDot to its original location.
- On the command bar, select Dynamic Edit again.
Activity: Creating and editing BlueDots

- Set both curves to Shape Edit and then repeat the previous step. Notice the different result.

- Click Undo to return the BlueDot to its original location.

- On the command bar, select Dynamic Edit again.

- Edit a BlueDot by specifying a delta distance. Repeat the previous step, but this time click the Relative/Absolute Position option on the BlueDot Edit command bar.
• Notice that the command bar changes to dX, dY and dZ. Type 20 in the dZ box and press the Enter key.

Note
If you press the Enter key a second time, a delta value of 20 is applied again.

• Click Undo to return the BlueDot to its original location.

• The 3D triad can be moved if it gets in the way. Click the 3D triad as shown and drag to a new location.
The activity is complete.

Summary

In this activity you learned how to draw and edit curves based on BlueDots.
C  Activity: Creating keypoint curves

Open surface lab 2-03.par.

Note
The part file contains three sketches that you use to create keypoint curves. Each sketch has seven keypoints.

Create a keypoint curve
Create the first keypoint curve using geometry from Sketch A.

▷ Click Surfacing tab→Curves group→Keypoint Curve
▷ Click the endpoint shown. Make sure the endpoint connect symbol displays.
Activity: Creating keypoint curves

Note
There are other keypoint select locations possible on a line. You can select endpoint (A), midpoint (B), line and endpoint (C) or line and midpoint (D). If you select a line and endpoint or a line and midpoint, the curve becomes tangent to the line at that point. You can modify the tangent vector. For this activity, only select endpoints.

▸ To make it easier to only select endpoints, click the Keypoints button on the command bar. Select the Endpoint option.

▸ Click the remaining endpoints in the following order.

▸ After clicking the last endpoint, click the Accept button, and then click Finish.
• Repeat the previous step to create keypoint curves using Sketches B and C.
Create keypoint curves between the sketches

Create seven keypoint curves between the sketches. The first curve is shown below and also the completed curves.
Activity: Creating keypoint curves

- Press **Esc**. Right-click in space, and then select Hide All → Sketches.

Note
The keypoint curves are not connected to each other. They are only connected to the sketch elements. If you edit one of the sketches used to keypoint connect to, the keypoint curve changes with edits made to the sketch.

Connect the keypoint curves with BlueDots
Connect the keypoint curves with BlueDots. Once a BlueDot is added, the history of how the curves were created is lost.

- Click the BlueDot command.  
Activity: Creating keypoint curves

- Click keypoint curve 1, and then click keypoint curve 2 as shown.

**Note**
Make sure no keypoints display when selecting the curves to BlueDot connect. Just click the curve away from any possible keypoint.

- Continue placing the remaining BlueDots. There are a total of 21 BlueDots. In case of a mistake, click the Undo command.

**Edit a BlueDot**
Edit a BlueDot and observe how the keypoint curves behave.

- Click the Select tool.
Activity: Creating keypoint curves

- Select the BlueDot shown.

- Click Dynamic Edit on the command bar.

- Click the Z-direction on the 3D triad.

- Drag the BlueDot up and notice how the two keypoint curves remain connected.

Note

Notice on the BlueDot Edit command bar that curve edit fields are not available. Keypoint curves cannot be controlled with local or shape edits.

- Click the Select tool. Right-click in the graphics window. Choose Hide All→BlueDots and Hide All→Curves.
Activity: Creating keypoint curves

Include tangency on keypoint curves

Create two keypoint curves that include a tangency vector.

▸ Click the Select tool.

▸ In PathFinder, select the check boxes next to features Extrude 4 and Extrude 5.

▸ Create keypoint curves between these two surfaces that are tangent to an edge of each surface. Click the Keypoint Curve command to begin.

▸ Select the endpoint of the surface edge as shown. Make sure the line and endpoint are highlighted.

▸ Select the endpoint of the surface edge as shown. Make sure the line and endpoint are highlighted.

▸ Click the Accept button.
Activity: Creating keypoint curves

- Click the End Conditions Step.

- Set the start and end tangent conditions to **Tangent**.

  **Note**

  Notice the green dot and line on each surface edge. These are the tangency vectors. The keypoint curve is tangent to the surface edge. By dynamically dragging the green dot, the curve changes shape while remaining tangent.

- Drag the tangency vectors as shown.
Activity: Creating keypoint curves

- Click Preview and then click Finish.
- Create another keypoint curve on the opposite edges of the surfaces.

Note
In the next lesson, you learn that the two keypoint curves you just created are a step in the process of constructing a tangent transition surface between two surfaces. The activity is complete.

Summary
In this activity you learned how to create and edit keypoint curves.
**D Activity: Additional curve creation methods**

Open *surface lab 2-04.par*.

**Note**

In order to create curves in this activity, existing construction surfaces are needed. Since you have not yet learned how to create surfaces, the surfaces needed in the activity have already been created for you.

**Create an Intersection curve**

- In PathFinder, select the check boxes next to features BlueSurf 1 and Extrude 1.
- Right-click in the graphics window and choose Hide All→Reference Planes.
- Create a curve where construction surfaces A and B intersect. Select Surfacing tab→Curves group→Intersection.
- On the command bar, set the Select filter to Feature.
- Select surface A, and then click the Accept button.
- Select surface B, and then click the Accept button.
Activity: Additional curve creation methods

- Click Finish.

![Diagram](image)

**Note**

In PathFinder, notice the intersection curve just created is named Intersection 2.

**Note**

The intersection curve is associative to the two input surfaces it was created from. These surfaces are the parents of the intersection curve. If a parent is edited, the intersection curve updates automatically.

In the next lesson you learn how you can use the intersection curve in surface editing operations.

- Hide the following features in PathFinder: *BlueSurf1, Extrude1* and *Intersection 2*

**Create a cross curve**

A cross curve is an intersection curve that is created with the theoretical extruded surfaces resulting from the two input curves or analytics.

- In PathFinder, show the following sketches: *Sketch 2a* and *Sketch 2b*.

- Select Surfacing tab→Curves group→Cross
Activity: Additional curve creation methods

- Click sketch A and then click the Accept button. Click sketch B and then click the Accept button.
Activity: Additional curve creation methods

- Click Finish.
  The cross curve is the result of the intersection of the two theoretical extruded surfaces A and B.

![Diagram showing A and B surfaces intersecting to form a cross curve]

Note
The Cross command eliminates the need to construct extruded surfaces from curves and then find the intersection between the two surfaces.

- Hide the sketch curves and cross curve: Sketch 2a, Sketch 2b and Cross Curve 8.

Project a curve
The Project (curve) command projects a curve onto a surface.
Show the following features in PathFinder: BlueSurf 2 and Sketch 3c.

- Project curve B onto surface A. Select Surfacing tab → Curves group → Project.
- Click the Options button on the command bar.
- The default option is Along vector. This projects a curve along its normal vector. Click OK.
- Select curve B and then click the Accept button.
- Select surface A and then click the Accept button.
Activity: Additional curve creation methods

- For the direction vector, point the direction arrow down as shown.

- Click Finish.

- Click the Select tool. In PathFinder, select the Projection feature and press the <Delete> key.

- Project the curve normal to the surface. Select the Project command again.

- Click the Options button.

- Select the Normal to selected surface option and click OK.
Activity: Additional curve creation methods

- Click the curve and then click the Accept button.
- Click the surface and then click the Accept button. Click Finish. Notice the different results.

Create a contour curve

- In PathFinder, show the feature BlueSurf 2.

- Select Surfacing tab → Curves group → Contour.
Activity: Additional curve creation methods

- Click the surface and then click the Accept button.
- Click the surface to place the six contour curve points approximately as shown. Points 1 and 6 are on the edge. Points 2 through 5 are on the face.

![Diagram showing six contour curve points]

**Note**

To insert points on an edge, set the command bar Select box to *Edges*. To insert points on the face, set the Select box to *Face*.

- After placing the last point, click the Accept button. Click Finish.

![Diagram showing the contour curve]

**Edit the shape of the contour curve**

- Click the Select tool.
- In PathFinder, right-click the contour curve feature and select *Edit Definition*.

**Note**

The shape can be edited while creating the contour curve.
• Click Draw Points Step

• Click the points shown and drag to edit the shape approximately as shown. Points 1 and 6 will remain attached to the edge. Points 2–5 can be moved anywhere along the face.
Activity: Additional curve creation methods

- Click the Accept button and then click Finish.

- Hide the two features *BlueSurf 2* and *Contour Curve 2*.

**Use the derived curve and split curve creation methods**

You can create derived curves from the four edges of a surface. Then you can split the derived curves that would be used to create additional surfaces. No surfaces are created in this activity.

- In PathFinder, show *BlueSurf 1*.

- Select Surfacing tab $\rightarrow$ Curves group $\rightarrow$ Derived $\rightarrow$.
Activity: Additional curve creation methods

- Click the edge shown, and then click the Accept button.

- Click Finish.

- Repeat the above step to create derived edges for the three remaining surface edges.

- Click the Select tool. Hide the surface.

- In PathFinder, show the Base Reference Planes.

- Select Surfacing tab→Curves group→Split
Activity: Additional curve creation methods

- Select the derived curve shown, and then click the Accept button.

- On the Split Curve command bar, set the Select filter to Body.
- Click the reference plane shown.
Click the Accept button, and then click Finish.

Notice the original derived curve is now split and there are two new curves that can be used for surfacing operations.
Activity: Additional curve creation methods

- Repeat the previous step to split the remaining three derived curves.
  The following image shows a new surface created using the split curves.

![Image of a new surface created using split curves]

Note
The BlueSurf construction method was used to create the surface above. You will learn how to create BlueSurfs in an upcoming lesson.

- The activity is complete. Exit and Save the file.

Summary
In this activity you learned how to create curves using several additional methods.
E Activity: Creating and editing simple surfaces

Open surface lab 3-01.par.

Create an extruded surface

- In PathFinder, show Sketch A.

- Select Surfacings tab → Surfaces group → Extruded.

- On the command bar, from the Create-From list, select Select from Sketch.

- Click the sketch curve shown and then click the Accept button.

- Click the Symmetric Extent button and type 150 in the Distance box.
Activity: Creating and editing simple surfaces

› Click Finish.

Modify the shape of the extruded surface

› Click the Select tool.

› In PathFinder, hide *Base Reference Planes*.

› Select the extruded surface and then click the Dynamic Edit button on the command bar.

› Click the sketch curve. Use the curve Local Edit option, and drag the edit point shown. Drag the edit point around slightly and notice how the surface shape changes.

› Click the Select Tool to end the dynamic edit, and then press **Esc**.

› In PathFinder, hide the features *Sketch A* and *Extrude 3*. 
Activity: Creating and editing simple surfaces

Create a revolved surface

Note
The Revolved Surface command has the same steps as the Revolve command.

▸ Show Sketch B.

▸ Select Surfacintab→Surfaces group→Revolved

▸ On the command bar, from the Create-From list, select Select from Sketch.

▸ Select the sketch curve shown and then click the Accept button on the command bar.

▸ Notice on the Revolved Surface command bar that the next step is to define the axis of revolution. Click the line as shown.

▸ For the extent step click the revolve 360° button.
Activity: Creating and editing simple surfaces

- Click Finish.

Edit the shape of the revolved surface
- Click the Select tool.
- Press Ctrl+R to rotate the view to a right view.
- Select the revolved surface and then click the Dynamic Edit button.
- Select the sketch curve. Use the curve Local Edit option and drag the edit point shown. Drag the control vertex point around slightly and notice how the surface shape changes.
- Drag the control vertices around to come up with your own surface shape.
- This concludes the activity.

Summary
In this activity you learned how to create simple surfaces using Extrude and Revolve, and how to edit the surfaces by manipulating their parent curves.
Activity: Creating a swept surface

Open surface lab 3-02.par.
The part file contains four sketches. Sketch element A is the guide path (curve) and sketch elements 1-3 are the cross sections (arcs).

Note
The Swept Surface command has the same steps as the Swept Protrusion command.

Create a swept surface

- Select Surfacings tab→Surfaces group→Swept [ ].
  In the Sweep Options dialog box, select Multiple paths and cross sections. Click OK.
Activity: Creating a swept surface

- For the Path step, select the curve shown and then click the Accept button.

- Since there is only one path, click the *Next* button on the command bar to proceed to the Cross Section step.

- Select cross section 1, and then click the Accept button. Select cross section 2 and click the Accept button. Select cross section 3 and click the Accept button.

- On the command bar, click *Preview* and then *Finish.*
Modify the shape of the surface

- Click the Select tool. Select the surface, and then click Dynamic Edit.
- Click the 70 mm radius dimension on cross section 1. Type 50 and press the Enter key.
- Click the 10 mm radius dimension on cross section 2. Type 40 and press the Enter key.
- Click the 60 mm radius dimension on cross section 3. Type 20 and press the Enter key.
Activity: Creating a swept surface

- Click the Select tool to end the dynamic edit. Press Esc to finish.

Dynamically edit the path curve

- Click the Select tool. Select the surface and then click Dynamic Edit.
- Click the path curve as shown.
Activity: Creating a swept surface

- Select the edit point shown and drag it to the right.

- The activity is complete.

Summary

In this activity you learned how to create and edit a swept surface.
**Activity: Creating a BlueSurf using analytics**

Open *surface lab 3-03.par*.

Create several BlueSurf features

- Select Surfacin tab→Surfaces group→BlueSurf
  Notice on the BlueSurf command bar that the Cross Section Step is active.

- To define the first cross section, click the arc shown and then right-click (or click the Accept button).
Activity: Creating a BlueSurf using analytics

- For the next cross section, click the arc shown and then right-click.

- For the last cross section, click the arc shown and then right-click.

- Click Preview and then click Finish.

Notice the BlueSurf feature shown in PathFinder; hide this feature.

Create another BlueSurf

- Click the BlueSurf command.

- For the first cross section, select the point shown.
Activity: Creating a BlueSurf using analytics

- Click the arc shown for the second cross section, and then right-click.

- Click the arc shown for the last cross section, and then right-click.

- Click Preview. Do not click Finish.

- Apply guide curves to the BlueSurf. Click the Guide Curve Step on the command bar.

- In the command bar Select list, click Single. This allows you to select single sketch elements for the guide curve.
Activity: Creating a BlueSurf using analytics

- Select sketch elements 1 and 2 as shown, and then right-click to complete the first guide curve.

![Diagram showing sketch elements 1 and 2](image)

**Note**

Notice how the BlueSurf follows the guide curve.

- Select sketch elements 3 and 4 as shown, and then right-click to complete the second guide curve.

![Diagram showing sketch elements 3 and 4](image)
Activity: Creating a BlueSurf using analytics

- Click Preview and then Finish.

- Hide this second BlueSurf feature.

Create a third BlueSurf

- Click the BlueSurf command.
- Click the point shown.

- Click the cross section shown and right-click.

- Click the point shown and right-click.
Activity: Creating a BlueSurf using analytics

- Click the Guide Curve Step.
- From the command bar Select list, select Single.
- Select sketch elements 1, 2, and 3 as shown, and then right-click. Select sketch elements 4, 5, and 6 as shown, and then right-click.

- Click Preview and then click Finish.

Add cross sections to the BlueSurf

- Click the Select tool, and then select the BlueSurf feature.
- Click Edit Definition.
Activity: Creating a BlueSurf using analytics

- Click the Cross section Step.

- Click the cross section shown and right-click.

- Click Edit on the error dialog box. The cross section order is the cause for the error. This will be corrected later.

- Click the BlueSurf Options button.

- Click the Advanced tab in the BlueSurf Options dialog box.
Activity: Creating a BlueSurf using analytics

Notice the order of the Sections in the dialog box. Position the cursor over a section and it highlights in the graphics window.

- Select Section 4, and then click the Up button to reorder the section between Sections 1 and 2.
- Select Section 5, and then click the Up button to reorder the section between Sections 2 and 3.
- Click OK.
Activity: Creating a BlueSurf using analytics

- Click Finish.

- The activity is complete.

Summary

In this activity you learned how to create and edit BlueSurf surfaces.
Activity: Creating and editing a BlueSurf

Note
The part file contains four curves that are BlueDot connected.

Open surface lab 3-04.par.

Create a BlueSurf with guides

- Select Surfacing tab→Surfaces group→BlueSurf
- Click curve 1 as shown for the first cross section and then right-click. Click curve 2 as shown for the second cross section and then right-click.
- Click the Guide Curve Step button.
Activity: Creating and editing a BlueSurf

- Click guide curve 3 as shown and then right-click. Click guide curve 4 as shown and then right-click.

- Click Preview, and then click Finish.

Insert sketches on the BlueSurf

You can insert sketches to provide additional shape control.

- Click the Select tool, and then select the BlueSurf feature.

- Click Edit Definition.

- Click the Options button on the command bar.
In the BlueSurf Options dialog box, under *Curve Connectivity* click *Use BlueDots*. Under *Inserted-Sketch*, in the Tolerance box, type .01. Click OK.

**Note**

The tolerance controls the number of edit points used on inserted sketches.

- Click the Insert Sketch Step button.
- Click the *Plane Normal to Curve* option.
- Click the curve shown.
Activity: Creating and editing a BlueSurf

- Notice a normal plane is attached to the curve, which can be dynamically dragged along the curve. Drag the plane until the *Position* value is 0.25. You also can enter .25 on the command bar. Click to place the plane.

- Repeat the previous step to insert sketches at positions .50 and .25 (from the opposite end) as shown.
Activity: Creating and editing a BlueSurf

- Insert sketches normal to the cross section curve. Click the curve shown and insert sketches at positions .25, .50 and .25 (from the opposite end).

- Click Finish twice.
Perform BlueDot edits to change the shape of the surface

Edit the BlueDots along the center by changing their position in the Z-direction.

- Click the Select tool. Select the BlueDot shown and then click *Dynamic Edit*. 
• Click the Z-axis on the 3D triad.

• Click the Relative/Absolute Position button.

Activity: Creating and editing a BlueSurf
Activity: Creating and editing a BlueSurf

- In the dZ box, type 5. Make sure Curves 1 and 2 are set to Shape Edit. Press the Enter key.

  **Note**

  If you press the Enter key again, the value is applied again.

- Click in open space in the graphics window to exit the BlueDot edit.

- Repeat the previous step to edit BlueDots 2 through 5. Edit BlueDot 5 with a delta distance of 5. Edit BlueDots 2 through 4 with a delta distance of 10.
Activity: Creating and editing a BlueSurf

- Right-click in the graphics window. Turn off the display of sketches and Bluedots.

- The activity is complete. Save and Close this file.

Summary

In this activity you learned how to create and edit a BlueSurf.
1 Activity: Surface manipulation

Open surface lab 4-01.par.

Extend a surface

- Select Surfacing tab→Surfaces group→Extend
- Select the edge shown and click Accept.

Note

Notice on the Extend Surface command bar the options for Natural, Linear and Reflective Extent. The Natural option extends the surface to follow the curvature of the surface. The Linear option extends the surface in a linear direction. The Reflective Extent option specifies that the extended portion of the surface is a reflection of the input surface. This option is not available for analytic surfaces.
Activity: Surface manipulation

- Drag the distance vector approximately as shown, and click.

- Click Finish.
- Click the Select tool.
- In PathFinder, select the new Extend feature and press the Delete key.
- Multiple edges can be extended. Select the Extend command again and select all four edges; click Accept.
Drag the distance vector approximately as shown and click.

Click Finish.
Click the Select tool.
In PathFinder, delete the Extend feature.

**Offset a surface**

- Select Sur-facing tab→Surfaces group→Offset.
- Click the surface, and then click Accept.
- Type 50 in the *Distance* box and press the Enter key.
Activity: Surface manipulation

- Position the direction arrow as shown, and click.

Note
The offset surface is offset along normal vectors from the input surface a distance of 50 mm.

- Click Finish.

- Create another surface offset from the original (bottom) surface. Use 50 for the offset distance, and position the direction arrow downward as shown.
Click Finish.

Click the Select tool.

In PathFinder, delete the two offset surfaces.

**Project a curve onto a surface**

- In PathFinder, show Sketch B.

- Select Surfacing tab→Curves group→Project command

- Select the circle shown below and then click the Accept button.
Select the surface and click Accept. Position the direction arrow as shown and click.

Click Finish.

**Project Curve** is still active. Select the circle shown below and then click the Accept button.
Activity: Surface manipulation

- Select the surface and click Accept. Position the direction arrow as shown and click.

- Click Finish.

- In PathFinder, hide Sketch B.

Trim a surface

Trim surface is used extensively in surface modeling.

- Select Surfacing tab→Surfaces group→Trim Surface.
- Select the surface and click Accept.
Select the projection curve as shown and click the Accept button.

Position the direction arrow as shown to trim the surface outside the projection curve.

Click Finish.

Select the surface and click Accept.

Select the projection curve as shown and click the Accept button.
• Position the direction arrow as shown to trim the surface inside the projection curve.

• Click Finish.
  Notice the two Trim features in PathFinder.

• Right-click and Hide All→Curves.

Copy a surface

• Select Surfacing tab→Surfaces group→Copy

Notice on the Copy Surface command bar the two options for removing boundaries. To remove internal boundaries on the copied surface, select the left button. To remove external boundaries on the copied surface click the right button. If neither option is selected, the copied surface maintains all boundaries.

• Click the Remove External Boundaries button.
Activity: Surface manipulation

- Select the surface and then click the Accept button.

- Click Finish.
  Notice the Copy feature in PathFinder.

- Click the Select tool.

- In PathFinder, delete the following features: Projection 11, Projection 12, Trim 11, Trim 12, and Copy 7.

- Hide feature Sweep A.

Delete faces

- Faces on a construction body can be deleted and replaced with a new surface.

- In PathFinder, show feature Extrude 2. Click the Fit command.

- Select Home tab→Modify group→Delete Faces.
• Select the three faces shown and click the Accept button.

• Click Finish.
  Notice the Delete Face feature in PathFinder.
Activity: Surface manipulation

- Hide feature *Extrude 2*. Show feature *Extrude 3*. The Extrude 3 feature was constructed with a closed profile and the ends were capped.

- Click the Delete Faces command.

- Click the Heal Option button on the command bar.

**Note**

For the heal option to work, the construction body must be closed.

- Select the surface shown and then click Accept.
Click Finish.

Notice the result. The face was deleted and the two adjoining faces adjust to fill the gap. The two end caps were also modified.

Repeating the previous step, delete the face shown.
Activity: Surface manipulation

- Click Finish.
- Click the Select tool.
- Hide Extrude 3.

**Stitch surfaces**

- In PathFinder, show features *BlueSurf 1, BlueSurf 2, BlueSurf 3*, and *BlueSurf 4*.

- Select Surfacing tab→Surfaces group→Stitched

- Type .01 in the *Stitch tolerance* box and then click OK.

- Select all four surfaces and then click the Accept button.

- Click Finish.
  
  Note in PathFinder the Stitch feature.

- Select Surfacing tab→Surfaces group→Stitched→Show Non-Stitched Edges
Activity: Surface manipulation

- Click the stitched surface. Notice the highlighted edges. These are the un-stitched edges.

- Click Close on the command bar.

- In order to make a solid feature there must be surfaces stitched to all of the non-stitched edges. Create surfaces needed to make a solid feature. Select Surfacint tab→Curves group→Keypoint Curve.

- Draw a keypoint curve as shown. The curve has two points.

- Create five bounded surfaces. Select Surfacint tab→Surfaces group→Bounded.

- Select the edges shown and click Accept.
Activity: Surface manipulation

- Turn off the Face Tangency option.
- Click Preview and then click Finish.

- Repeat the same steps to create the bounded surface shown.
• Repeat the steps for the three circular edges.

![Diagram of steps](image)

• Select the **Stitched** command. Type .01 in the *Stitch tolerance* box and click OK.

• Select the stitched surface and then select the five bounded surfaces.

• Click the Accept button. Since there are no non-stitched edges remaining, the stitched surfaces result in a solid body. Click OK in the message dialog box.

• Click *Finish*.

**Note**

If there is no base feature (solid) in the file, you can right-click on the stitched surface and click Make Base Feature to create a solid of the stitched surface.

• Click the Select tool.

• Hide features BlueSurf 1-4 and the keypoint curve.
Replace a face

- Select View tab→Show group→Construction Display. In the Show All/Hide All dialog box, choose Show All→Design body. Protrusion $A$ is displayed. Replace faces $A$ and $B$ on Protrusion $A$ with a construction surface.

![Diagram of a model with faces A and B highlighted]

- Show feature BlueSurf 7.

![Diagram of a model with BlueSurf 7 feature]

- Select Surfacing tab→Surfaces group→Replace Face

- Select the faces shown and click the Accept button.
Activity: Surface manipulation

- Select the surface shown for the replacement surface.

- Click Finish.

- Click the Select tool.

- Replace the bottom face on the protrusion. Show BlueSurf 8.

- Click the Replace Face command.
Activity: Surface manipulation

- Select the face as shown and click the Accept button.

- Select the surface shown for the replacement surface.

- Click Finish.

- This completes the activity. Exit and save the file.

Summary

In this activity you learned how to use several surface manipulation commands.
**Activity: Parting split and parting surface**

Create a new metric part file using the ISO Part template. In PathFinder, right-click the Synchronous header and select **Transition to Ordered**.

**Note**

You will begin by constructing a core for the mold. The core needs to be sized to accommodate the file `pad.par` that will be the cavity.

**Create a sketch**

- Select the check box next to *Base Reference Planes* to show them.

- Select *Home tab→Planes group→More Planes→Parallel*.

- Select the *Top (xy)* base reference plane indicated by the arrow. Create a parallel plane 35 mm above it as shown.
Activity: Parting split and parting surface

- Sketch the following profile on the parallel plane you just created. Make sure the midpoints of the line elements are horizontal/vertical aligned to the center of the reference planes.

![Sketch](image)

- Click Close Sketch and then click Finish.

Create the core part

- Select Home tab→Solids group→Extrude.
- Click the Select from Sketch option on the command bar.
- Select the sketch shown and click the Accept button.
Activity: Parting split and parting surface

- Click the Symmetric Extent button and type 200 for Distance. Click Finish.

- In PathFinder, hide Sketch1.

Create the cavity

To create the cavity, use the Boolean difference to remove pad.par from the core.

- Select Home tab→Clipboard group→Part Copy.

- In the Select Part Copy dialog box, set Look in to the folder in which you installed the training parts for this course. Select pad.par and click Open.

- In the Part Copy Parameters dialog box, make sure Design Body is checked and then click OK.
Activity: Parting split and parting surface

- Click Finish. Notice the feature Part Copy 1 is now listed in PathFinder. Use your cursor to highlight this entry in PathFinder, and you can see the pad highlight in the graphics window.

- Select Surfacing tab→Surfaces group→Replace Face→Boolean

- Click the Subtract button.

- Select the Part Copy and then click the Accept button.

- Click Finish. Notice the Boolean 1 feature listed in PathFinder.
The core now has a cavity of pad.par.

**Create a parting split curve on the cavity**

A parting split curve is derived from silhouette edges as viewed normal to a selected plane. The parting split curve defines where a part needs to split to allow for removal from a mold.

- Select Surfacing tab→Surfaces group→Split→Parting Split
- Select the plane shown; it is the Top (xy) base reference plane.

  **Note**

  You may want to change to a Wireframe view style for better visibility.

- On the Parting Split command bar, set the Select filter to *Body*. 
Select the body as shown.

Click the Accept button and then click Finish.

Position your cursor on Parting Split 1 in PathFinder and notice the parting split is highlighted in the graphics window.

Create a parting surface

This surface will be used to split the core in a later step.

Select Surfacing tab→Surfaces group→Split→Parting Surface
Select the plane shown; it is the Top (xy) base reference plane.

**Note**

The parting surface will use this plane as reference for all normal vectors in creating the surface.

Select the parting split curve as shown and click the Accept button.

Type 150 in the Distance field and press the <Enter> key.
Activity: Parting split and parting surface

- Position the arrow to point outward as shown and click. Click Finish.

- Save the file as pad core.par in the course training folder.

Divide the part

Split the core along the parting surface to create two mold halves.

- Select Surfaces tab→Surfaces group→Replace Face→Divide Part
Activity: Parting split and parting surface

- Select the parting surface shown as the surface to be used to divide the core.

- Position the direction arrow as shown as the side to be divided into a new file.

- Click Finish.
• In the Divide Part dialog box, notice the two new divided parts.

• Name the parts. Click the first `<click here to enter a filename>` entry, and type `top`. Click the second `<click here to enter a filename>` entry, and type `bottom`. Do not click Close.

• Click the Select All button.

• Click the Save Selected Files button.
The two new files are created and notice that they are linked to the parting surface. Click Close.

Open each of the two mold halves
  - Close pad core.par.
Activity: Parting split and parting surface

- Open \textit{top.par} in the course training folder.

\textbf{Note}

The base coordinate system and reference planes are hidden in the following images.

\begin{figure}
\centering
\includegraphics[width=0.5\textwidth]{image1.png}
\caption{A part with a parting split and parting surface.}
\end{figure}

\textbf{Note}

In this image, the part was flipped 180° to show the cavity.

- Close \textit{top.par} and open \textit{bottom.par}.

\begin{figure}
\centering
\includegraphics[width=0.5\textwidth]{image2.png}
\caption{Parting surface shown in a different orientation.}
\end{figure}

- The activity is complete. Close all files.
Summary

In this activity you learned how to construct two halves of a mold from a single core part.
**K Activity: Creating a rotary razor body**

Create a new metric part file using the *ISO Part* template. In PathFinder, right-click the Synchronous header and select **Transition to Ordered**.
Create an extruded surface

Sketch the profile

- Ensure that the Base Reference Planes are displayed.
- Sketch the following profile on the Top (xy) reference plane.

**Note**

Ensure you place the horizontal relationship between the midpoint of the top line and the origin. Also, place a point (Home tab→Draw group→Point) at the intersection of the reference planes.

- Select Tools tab→Variables group→Variables. Set a variable to define the dimension A as twice the value of B.
- Close the sketch and Finish.

- Select Surfacing tab→Surfaces group→Extruded

**Note**

Ensure that the command bar symmetric extent options are turned off.

- Extrude the sketch 12 mm below the plane. Keep the ends open.
Create a curve

The curve serves as the spine of the razor.

- Sketch on the Right (yz) reference plane an arc and line using the dimensions shown in the following image.

Place an Arc by 3 Points, selecting the point placed in the first sketch as the start location and making the top end tangent to the Front (xz) reference plane.

Note

You may want to rotate the view slightly to facilitate seeing the point and the Front plane.

- Close the sketch, and then click Finish on the command bar.
Activity: Creating a rotary razor body

Sketch a cross-section

- Create a sketch on a plane normal to a curve. Place the plane at the bottom end of the arc.
Activity: Creating a rotary razor body

- Using the pierce point of the arc through the plane, create an ellipse. Assign a primary radius of 18 mm and a secondary radius of 15 mm to the ellipse.

- Close the sketch, then click *Finish* on the command bar.

**Create additional curves**

The additional curves represent the backbone or spine of the razor body.

- Sketch on the Right reference plane and create a curve beginning from the bottom of the extruded surface (1). Use 3 to 4 points to define this curve, using the pierce point at the top of the ellipse for the final point on the curve (2).
Activity: Creating a rotary razor body

Ensure that a vertical align relationship (3) is defined between the top end of this curve and the existing surface (1). Do not be overly concerned about exact shape.

To place the horizontal/vertical relationship at the start of the curve, select the control vertex (A) and then select the extruded surface edge (B).
Activity: Creating a rotary razor body

- Place an Arc by 3 Points starting with the midpoint of line (A). Use the pierce point at the end of the curve (B) for the second point of the arc. For the third point, move the cursor between the first two points until you get the tangent symbol (C) and then click. Also apply an end connect relationship between the two curves.

- Close the sketch, then click Finish on the command bar.

- Sketch another curve on the Right plane. Start the curve at the surface and end it at the pierce point for the ellipse.
Activity: Creating a rotary razor body

- Create an arc between the end of the curve just placed and the existing arc.

- Apply a tangent relationship between the top of the curve (1) and the surface. Also, define end connect and tangent relationships between the curve and arc (2). Ensure that an end connect relationship is shared with the two arcs (3).
Activity: Creating a rotary razor body

- Experiment with the shape of the curves using Edit Profile. Edit the shape of the spline. The command bar offers several options for editing the curve points, as well as the ability to add points.

  The curve control points are visible.

- Drag some of these points to observe how the movement of one point affects the entire curve.
• Make a shape similar to the following.
Create a BlueSurf

All of the curves necessary to create the razor body exist. The Blue Surf command will be used to generate a surface based on a series of participating curves.

- Select Surfaces group → BlueSurf
Activity: Creating a rotary razor body

- In the Add Cross Sections step, select the point at the bottom of the curves.

- Select the ellipse as the next cross section.

- For the final cross section, pick the bottom edge chain from the protruded surface placed in Step 1.
Select the *Guide Curves* step and select each of the spine curves and Accept each in turn.

**Note**

Use the Single option when selecting the curves to ensure you do not select the entire chain.

The Blue Surf updates as shown in the following images.

- Click *Preview*. The result should look similar to the following. Click *Finish*.

- Hide all sketches.

**Create a bounded surface**

Close off the top of the original extruded surface.
Activity: Creating a rotary razor body

- Select the Bounded command.
- Select each edge around the top.

Stitch together the surfaces

The set of surfaces will be stitched together to form a solid body. The Stitched Surface command is used.

- Select the Stitched Surface command. In the Stitched Surface Options dialog box, click OK to accept the default options.
  Drag a box around all of the surfaces to select them.
Accept. Click Yes in the dialog box to accept the solid body.

Create a reference plane

Create an Angled reference plane off the Front (xz) plane, using the top bounded surface as the base of the profile plane. Orient it as shown below at an angle of 45°.
Create an opening for the power button

- Create a parallel plane offset 28.6 mm from the angled plane just created. Select Home tab→Solids group→Cut, and then sketch a profile on this new plane. Use two arcs defined by the radii shown.
Activity: Creating a rotary razor body

- Cutout the BlueSurf at a depth of 61 mm.
Create a port for the power cord

- Using the Cut command, sketch on the angled reference plane created in Step 9. Create a line as shown in the following image. Ensure that the left endpoint is created with a Point on element relationship to the silhouette of the body (1).

Dimension this line to the top edge of the razor body, with a value of 150 mm.
Activity: Creating a rotary razor body

- Select the cut direction shown to remove material from the bottom. Use the Through-All extent.

- Click Finish.

Split the solid body into two

- Choose the Parting Split command
Activity: Creating a rotary razor body

- For the planar face selection, select the angled plane previously defined.

- For the face to be split, change the Select list to Body, and select the entire razor body. Accept the body.
Offset the rear surface

- Select the Offset Surface command.
- Offset the rear surface inside by 3 mm.

- Use the Extend command to extend the new offset surface.
Activity: Creating a rotary razor body

- Select the top edge and extend it with natural curvature a distance of 18.95 mm.

Create a space for additional razor components

- Use the Cutout command to create a feature needed for additional razor components.
For the sketch plane, select Parallel Plane and select the angled plane created previously. Offset the new plane 58 mm.
Activity: Creating a rotary razor body

- Sketch the profile.
For the cut depth (extent), the cut should terminate at the surface extended previously. To do this, use the From-To extent option on the Cut command bar. The From entity is the angled plane of the sketch; the To entity is the surface extension.

Hide the extended surface.

Apply a thin wall to the part

- Click the Thin Wall command
- Use the Thin Wall command towards the outside of the part, defining a thickness of 2 mm.
Activity: Creating a rotary razor body

- As open faces, select the top face, as well as the bottom surface of the power switch.

  **Note**
  
  Ensure the Select option is set to Single.

**Round edges**

Round two edge chains using the Round command.

- Select the two edge chains at the power switch opening top and bottom, respectively. Apply a radius of 1 mm in each case.
• This completes the construction of the razor body.

Summary

In this activity, you used several curve and surface creation and manipulation techniques to design a rotary razor body. The methods utilized in the construction of this model are commonly applied during the design of consumer products due to the emphasis on ergonomic and aesthetic requirements.
Activity: Putting it all together

Open surface lab 4-02.par.

Note

Control Drawings were discussed in the previous lesson *Surface Modeling*. For this activity the control drawing is provided. For ease of viewing, the curves in each sketch are color-coded, and color references will be made when appropriate.
Activity: Putting it all together

Control sketches (A=Right View-ORANGE, B=Front View-PURPLE, C=Top View-GREEN)

Construct the top surface

First you’ll create intersection curves to be used to develop the top surface.

- Select Surfacing tab→Curves group→Cross
- Ensure the Select from Sketch option is active.
Select sketch element (A)—PURPLE—and then click the Accept button. Select both sketch elements (B)—GREEN—and then click the Accept button.

Click Finish.

Select Cross Curve.
Activity: Putting it all together

- Select sketch element (A)—ORANGE—and then click the Accept button. Select sketch element (B)—GREEN—and then click the Accept button. Click *Finish*.

- To create the top surface, select Surfacing tab→Surfaces group→Swept.

- In the Sweep Options dialog box, select the *Multiple paths and cross sections* option.
• For the Path Step, select path (A) and click the Accept button or click the right mouse button. Select path (B) and click the Accept button or right-click.

• Click Next to proceed to the Cross Section step.

• Select cross section (A) and right-click. Select cross section (B) and right-click. Select cross section (C) and right-click.
Activity: Putting it all together

- Click Preview and then Finish.

Create intersection curves to develop the front surface

- Hide the swept surface you just created.

- Select Cross Curve.

- Select sketch element (A)—PURPLE—and then click the Accept button. Select both sketch elements (B)—ORANGE—and then click the Accept button.

- Click Finish.
Activity: Putting it all together

- Select **Cross Curve**.

- Select sketch element (A)—ORANGE—and then click the Accept button. Select sketch element (B)—GREEN—and then click the Accept button. Click **Finish**.

- Click **Finish**.
Activity: Putting it all together

- Save the file.

- Select **Swept**. Click the *Multiple paths and cross sections* option and set the *Section Alignment* to Parallel.

- Use QuickPick to select path (A). Make sure you select the cross curve element and then click Accept. Select path (B) and right-click.

- Click *Next* to define the cross sections.

- Set the Select filter to *Single*. Select cross section (A) and right-click.

- Select cross section (B) and right-click.
Activity: Putting it all together

- Select cross section (C) and right-click.

- Click Preview and then Finish.

- Save the file.

Create intersection curves to develop the side surfaces

- Hide the swept surface you just created.

- Select Cross Curve.

- Change the Select option to Single.
Activity: Putting it all together

- Select sketch element (A)—PURPLE—and then click the Accept button. Change the Select option to Single. Select both sketch elements (B)—GREEN—and then click the Accept button.

- Click Finish.

- Select Cross Curve.

- Set the Select option to Single. Select sketch elements (A)—PURPLE—and then click the Accept button.

  **Note**

  There are two elements in (A).
Set the Select option to *Single*. Select both sketch elements (B)—GREEN—and then click the Accept button. Click Finish.

Click *Finish*.

Select Surfacing tab→Surfaces group→Bounded.
Activity: Putting it all together

- Select the six edges as shown. Use QuickPick for edges A and B to ensure you select the cross curve edges.

- Click the accept button. Ensure Face Tangency is off.

- Click Preview and Finish.
Activity: Putting it all together

- Create another bounded surface on the other side.

Create the bottom surface

- Show all base reference planes. Select Home tab→Sketch group→Sketch.
Activity: Putting it all together

- Select the plane Right (yz) for the first sketch.

- Hide all surfaces.
- Draw the following sketch.

- Select Close Sketch.
For the second sketch, create the sketch on a parallel plane as shown. To define the distance, click the keypoint as shown.

Select Home tab→Draw group→Include, and select the arc shown.

**Note**
Click OK in the Include Options dialog box.

Select Close Sketch.

Select BlueSurf.
Activity: Putting it all together

- Select cross section (A) and right-click. Select cross section (B) and right-click.
• Hide all of the base reference planes.

• Click the Guide Curve Step.

• Select guide curve (C) and right-click.

• Set the Select option to Single to select the two elements in guide curve (D). Select guide curves (D) and right-click.

• Set the Select option to Chain to select guide curve (E). Select guide curve (E) and right-click.

• Click Preview and Finish.
Activity: Putting it all together

- Save the file.
- Show all of the surfaces created so far.

Add another surface

You will add the surface as shown below.
• Hide all of the surfaces except the BlueSurf just created.

• To create this surface, an intersection curve is needed between the bottom BlueSurf and an extruded surface created from the element shown in the control sketch. Create an extruded surface with a symmetric extent from the element shown in the image below. Do not be concerned with an exact distance, just extend it similar to the image.
Activity: Putting it all together

- Select Surfaces tab→Curves group→Intersection. Select the BlueSurf and the extruded surface as the surface set to intersect. The intersection curve is shown in the image below. Hide the extruded surface after the intersection curve is created.

- Hide all sketches. Select Surfaces tab→Surfaces group→Trim. Select and accept the BlueSurf. Change the Select option to Chain. Select the intersection curve and make sure the arrow points in the direction shown.

- Click Finish.
Create the final surface

- Show all sketches and curves.
- Select BlueSurf.
Select the cross sections shown. Set the Select option to Single in order to select the first cross section (A). Select cross section A and right-click. For the second cross section (B), set the Select option to Single in order to select the cross section. The second cross section (B) has 3 segments. Use QuickPick to ensure you pick the intersection edges. Select cross section B and then right-click.

After selecting cross sections (A) and (B), click the Guide Curve Step. Set the Select option to Single, select the curve (C) and then right-click.
• Click Preview and then Finish.
• Choose Select and right-click. Select:
  • Hide All→Sketches
  • Hide All→Curves
  • Show All→Surfaces

Note
Hide the extruded surface you created as a construction surface.
Activity: Putting it all together

Cap the ends

- Select Bounded. Select the edges shown for (A) and make sure face tangency is turned off. Select the edges shown for (B) and again make sure face tangency is turned off.

The surface model is complete.

Stitch together the surfaces

The surface model now can be converted to a solid base feature.

- Select Stitched Surface and type .01 in the Stitch tolerance box. Click OK.
Select all surfaces and then click the Accept button. Click Yes in the resulting solid message dialog box.

This completes the bathtub spout lab activity.

Note
You rarely get the surface you want from the initial surface creation method. You also need to manipulate the surface by adding boundaries, creating an offset, extending, rounding, and so on.

Solid Edge provides several commands for you to use to develop the final surface shape. A good understanding of these tools will help you master surface modeling.

Summary
In this activity you learned how to create a solid model from control curves using multiple curve and surface manipulation techniques.